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Important User Information Solid state equipment has operational characteristics differing from those of 
electromechanical equipment. Safety Guidelines for the Application, 
Installation and Maintenance of Solid State Controls (Publication SGI-1.1 
available from your local Rockwell Automation sales office or online at 
http://www.ab.com/manuals/gi) describes some important differences 
between solid state equipment and hard-wired electromechanical devices. 
Because of this difference, and also because of the wide variety of uses for 
solid state equipment, all persons responsible for applying this equipment 
must satisfy themselves that each intended application of this equipment is 
acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for 
indirect or consequential damages resulting from the use or application of 
this equipment.

The examples and diagrams in this manual are included solely for illustrative 
purposes. Because of the many variables and requirements associated with 
any particular installation, Rockwell Automation, Inc. cannot assume 
responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to 
use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without 
written permission of Rockwell Automation, Inc. is prohibited.

Throughout this manual, when necessary we use notes to make you aware of 
safety considerations.

WARNING
Identifies information about practices or circumstances 
that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property 
damage, or economic loss.

IMPORTANT Identifies information that is critical for successful 
application and understanding of the product.

ATTENTION Identifies information about practices or circumstances 
that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you:

• identify a hazard

• avoid a hazard

• recognize the consequence

SHOCK HAZARD Labels may be located on or inside the equipment (e.g., 
drive or motor) to alert people that dangerous voltage may 
be present.

BURN HAZARD Labels may be located on or inside the equipment (e.g., 
drive or motor) to alert people that surfaces may be 
dangerous temperatures.
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Preface

Objectives This preface provides information on:

• Intended audience

• Parts list

• Contents of manual

• Additional Resources

• Software and firmware upgrades

• European Communities (EC) Directive Compliance

Intended Audience Use this manual if you are responsible for installing, operating, or 
troubleshooting the VersaView CE terminals. 

No special knowledge is required to understand this manual or 
operate the terminal. However, it is important that you understand the 
functions and operations of Machine Edition applications that will run 
on the terminal. Consult the application designer for this information.

Equipment installers must be familiar with standard panel installation 
techniques. 

Parts List The VersaView CE terminals ship with:

• Windows CE .NET operating system pre-installed with Terminal 
Services and Internet Explorer

• Accessory CD with utilities and software development kit for 
C++

• Power terminal block

• RSView Machine Edition Runtime (preloaded) 

• Mounting clips (quantity 4 to 8)

• Microsoft Windows CE License Agreement

• Installation instructions

• Panel cutout template 
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Manual Contents
Chapter Title Description

1 Overview Provides an overview of the terminals 
including features and product 
components.

2 Installation Gives instructions on how to install 
the terminal in a panel or enclosure.

3 Connect Power Describes how to connect power to 
the terminal, and reset the terminal.

4 Using RSView ME Station Shows how to use RSView ME 
Station to load and run applications, 
and configure terminal settings.

5 Windows CE .NET Operating 
System

Covers general information on 
Windows CE .NET, its use with the 
terminal, and control panel 
applications for configuring the 
terminal.

6 Install and Replace Components Shows how to install and replace 
components of the terminal. 

• Logic module

• Communication module

• Display module

• RAM/Internal compact flash

• Battery

• Display module bezel

• Backlight

• AC power supply

• Product label

• Keypad legend inserts

• External compact flash card

7 Terminal Connections Describes connections on the base 
unit of the terminal and the 
communication modules. 

8 Transfer Files Shows how to transfer files, create 
an ActiveSync connection, and use 
the Firmware Upgrade Wizard to 
upgrade terminal firmware. 

9 Troubleshooting Provides assistance on isolating and 
correcting problems.
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Additional Resources For additional information, refer to these publications which you can 
download from:

http://www.rockwellautomation.com/literature

You may also want to refer to:

• Online help for RSView Studio or RSLinx

• Documentation for your logic controller or processor

Software and Firmware 
Upgrades

To receive software updates (software serial number required) and 
firmware upgrades for your terminal:

• Call your local Rockwell Automation sales office or distributor

• Call Rockwell Software at 1-440-646-7800 or fax 1-440-646-7801

• access www.software.rockwell.com

Publication Publication Number

Software Development Kit for VersaView CE Terminals 6182H-UM002

ControlNet Communications for VersaView CE Terminals. 2711P-UM003

Creating Modbus Applications for VersaView CE Terminals 2711P-UM002

Wiring and Grounding Applications for PanelView Plus and 
VersaView CE terminals

2711P-TD001
Publication 6182H-UM001D-EN-P - September 2005



Preface        4
European Communities (EC) 
Directive Compliance

If this product has the CE mark it is approved for installation within 
the European Union and EEA regions. It has been designed and tested 
to meet the following directives.

EMC Directive

This product is tested to meet the Council Directive 89/336/EC 
Electromagnetic Compatibility (EMC) by applying the following 
standards, in whole or in part, documented in a technical construction 
file:

• EN 50081-2 EMC - Generic Emission Standard, Part 2 - Industrial 
Environment

• EN 61000-6-2 EMC - Generic Immunity Standard, Part 2 - 
Industrial Environment

This product is intended for use in an industrial environment.

Low Voltage Directive

This product is tested to meet Council Directive 73/23/EEC Low 
Voltage, by applying the safety requirements of EN 61131-2 
Programmable Controllers, Part 2 - Equipment Requirements and 
Tests. For specific information required by EN 61131-2, see the 
appropriate sections in this publication, as well as the Allen-Bradley 
publication Industrial Automation Wiring and Grounding Guidelines 
For Noise Immunity, publication 1770-4.1.

Open style devices must be provided with environmental and safety 
protection by proper mounting in enclosures designed for specific 
application conditions. See NEMA Standards publication 250 and IEC 
publication 529, as applicable, for explanations of the degrees of 
protection provided by different types of enclosure.

Allen-Bradley, ControlLogix, DH+, PLC-2, PLC-3, PLC-5, RSView, SLC and VersaView are registered trademarks 
of Rockwell Automation.

CompactLogix, FlexLogix, InView, Logix, MicroLogix, PanelView, PanelView Plus, RSLogix, RSView32 and 
SoftLogix are trademarks of Rockwell Automation.

All other trademarks are properties of their respective holders, and are hereby acknowledged.
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Chapter 1

Overview

Chapter Objectives This chapter gives an overview of the VersaView CE 700H, 1000H, 
1250H, and 1500H devices including:

• Hardware features

• Software support

• Modular components

• Base configured unit

• Communication modules

• Remote AC power supply

• Display modules

• Catalog number configuration and product components

Hardware Features

The VersaView CE terminals are operating and display devices that 
run RSView Machine Edition in an open Windows CE.NET 
environment. Features include:  

• Graphic color display modules with keypad, touch screen, or 
keypad & touch screen support

• 650 MHz Celeron processor

• Analog resistive touch screen

• Field replaceable bezels 

• Modular communications for easy add-on capability

• Memory expansion modules for field upgrades to 256 MB RAM 
and 512 MB compact flash.

• Compact flash card slot supports Type I compact flash cards

• USB ports provides connections for keyboard/mouse/printer

• Ethernet and serial communications 

• Same panel cutouts as the PanelView Standard and PanelView 
Enhanced terminals
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1-2        Overview
Software Support The open Windows CE.NET (4.1) environment of the VersaView CE 
terminals offer: 

• Familiar Windows desktop and user interface

• Terminal Server Client support to configured servers 

• Internet Explorer

• Software Development Kit to support custom C++ applications 
for Windows CE.NET 

• Third party device support for Windows CE.NET 

• Windows CE.NET contains the following programs: 

– File Viewers for MS Office: Excel, Word, PowerPoint

– PDF File Viewer

– WordPad Text Editor

– WebServer

– FTP Server

– Support for the .NET Compact Framework

Some of the above software applications are included on the 
VersaView CE Accessory CD.

RSView Machine Edition software is included with the VersaView CE 
terminal and does not require activation.

Modular Components The terminals use modular components allowing for flexible 
configuration, installation, and upgrades. Items can be ordered as 
separate components or factory assembled per your configuration.

Communication Module

Logic Module

Display Module
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Overview        1-3
Base Configured Unit The base configured unit of the terminal consists of: 

• Display module (700H, 1000H, 1250H, 1500H) with keypad, 
touch or keypad & touch input

• Logic module

The logic module contains:

• 24V dc input (18 to 32V dc)

• SDRAM and flash memory (various sizes)

• Celeron 650 MHz processor

• 10/100BaseT Ethernet port

• Serial RS-232 port for file transfers, printing and logic controller 
communications

• Two USB ports for attaching mouse, keyboard or printer

• Compact flash card slot for Type I compact flash cards

• Battery-backed real-time clock

DC Input

Ethernet Port

Serial PortCompact Flash Card Slot

Logic Module

USB Ports

Display Module
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1-4        Overview
Communication Modules You can attach a communication module with a network interface to 
the base configured unit of the terminal to increase your 
communications capability.  

• DH+/DH485/Remote I/O

• DeviceNet

• ControlNet 

The communication module installs easily on top of the logic module 
on the back of the unit. 

Remote AC Power Supply The logic module provides DC power input. For applications using AC 
power, a remote AC to DC power supply is available for DIN Rail 
mounting.

Communication Module
Publication 6182H-UM001D-EN-P - September 2005



Overview        1-5
Display Modules The terminals offer a range of TFT color graphic displays with either 
keypad, touch screen, or keypad & touch support. 

• 700H (6.5 inch)

• 1000H (10.4 inch)

• 1250H (12.1 inch) 

• 1250H High-Bright Touch (12.1 inch)

• 1500H (15 inch)

All displays have common features and firmware providing for easy 
migration to a larger display. Field replaceable bezels are also 
available.

Touch Screen

The illustration shows a 1000H touch screen display. All touch screen 
displays are analog resistive and similar except for size. 

IMPORTANT Use a plastic stylus device with a minimum tip radius 
of 1 mm (0.040 in) to prevent damage to the touch 
screen.

IrDA Port
(if present)

Allen-Bradley  Label

Touch Screen
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1-6        Overview
Keypad or Keypad & Touch Screen

The illustration shows the features of the 1000H keypad or keypad & 
touch display. All displays are similar except for size and the number 
of function keys available.
 

The Kxx and Fxx function keys on the keypad terminals are 
programmable. Appendix B provides a list of the Windows virtual key 
codes for each key.

Backspace 
and Enter Key

Navigation Keys

Numeric Keypad

Programmable Function Keys
(optional custom legends) 

Allen-Bradley Label

Tab, Shift Keys

Esc, Ctl, Alt Keys

Programmable Function Keys
(optional custom legends) 

Feature Description

Function Keys 
700H (F1-F10, K1-K12) 
1000H (F1-F16, K1-K16) 
1250H (F1-F20, K1-K20) 
1500H (F1-F20, K1-K20) 

Programmable keys that initiate functions 
on terminal display. Replaceable legends 
are available for the terminals allowing for  
custom function key labels.

Label Allen-Bradley or customer applied label.

Numeric Keypad 0-9, ., -, Backspace, Enter, Tab, Shift, Esc, 
Ctrl, Alt keys

Navigation Keys Use the arrow keys to move cursor in lists, 
select objects, 

Alt+arrow key activates home, end, page 
up, page down functions.
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Catalog Number 
Configuration

The table lists the catalog number configuration for the terminals.

Product Components Components are available as separate catalog numbers for field 
installation and replacement.

Display Modules

Communication Modules

Size Input Flash/

RAM

Comms Power

| | | | |

6182H- 7 = 6.5 inch K = Keypad RH = 128 MB/128 MB 4 = Standard Communication (Ethernet & RS-232) B = AC DIN

10 = 10.4 inch T = Touch EH = 256 MB/256 MB 6 = DH+, DH-485, RIO & Standard Communication D = DC

12 = 12.1 inch B = Both 10 = DeviceNet & Standard Communication

15 = 15 inch 15 = ControlNet & Standard Communication

Cat. No. VersaView CE Display Type

6189-RDK7C 700H Keypad Color Display

6189-RDT7C 700H Touch Color Display

6189-RDB7C 700H Keypad and Touch Color Display

6189-RDK10C 1000H Keypad Color Display

6189-RDT10C 1000H Touch Color Display

6189-RDB10C 1000H Keypad and Touch Color Display

6189-RDK12C 1250H Keypad Color Display

6189-RDT12C 1250H Touch Color Display

6189-RDT12H 1250H Touch and High-Bright Touch Color Display

6189-RDB12C 1250H Keypad and Touch Color Display

6189-RDK15C 1500H Keypad Color Display

6189-RDT15C 1500H Touch Color Display

6189-RDB15C 1500H Keypad and Touch Color Display

Cat. No. Description

2711P-RN6 DH+/DH-485/Remote I/O Communication Module

2711P-RN10H DeviceNet Communication Module

2711P-RN15S ControlNet Communication Module
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Remote AC Power Supply

Logic Module

Internal Compact Flash Cards

RAM Memory

Compact Flash Cards (Blank)

Cat. No. Description

2711P-RSACDIN AC to DC DIN Rail Power Supply, 85…265V ac, 47…63 Hz

Cat. No. Description

6189-RP Logic Module without Flash/RAM Memory 

6189-RPRH Logic Module with 128 MB Flash/128 MB RAM

6189-RPEH Logic Module with 256 MB Flash/256 MB RAM

Cat. No. Description

6189-RW2 128 MB Compact Flash with RSView Machine Edition

6189-RW3 256 MB Compact Flash with RSView Machine Edition

6189-RW4 512 MB Compact Flash with RSView Machine Edition

Cat. No. Description

2711P-RR64 64 MB SODIMM Memory 

2711P-RR128 128 MB SODIMM Memory 

2711P-RR256 256 MB SODIMM Memory 

Cat. No. Description

2711P-RC2 128 MB Blank Compact Flash Card

2711P-RC3 256 MB Blank Compact Flash Card

2711P-RC4 512 MB Blank Compact Flash Card

2711P-RCH Compact Flash to PCMCIA Adapter
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Legend Kits 

Protective Antiglare Overlays

Replacement Bezels

Cat. No. Description

2711P-RFK7 Replacement Legend Strips for 700H Keypad Terminal

2711P-RFK10 Replacement Legend Strips for 1000H Keypad Terminal

2711P-RFK12 Replacement Legend Strips for 1250H Keypad Terminal

2711P-RFK15 Replacement Legend Strips for 1500H Keypad Terminal

Cat. No. (1)

(1) All catalog numbers ship with a quantity of three overlays.

Description

2711P-RGK7 Antiglare Overlay for 700H Keypad or Keypad/Touch Terminal

2711P-RGT7 Antiglare Overlay for 700H Touch Terminal

2711P-RGK10 Antiglare Overlay for 1000H Keypad or Keypad/Touch Terminal

2711P-RGT10 Antiglare Overlay for 1000H Touch Terminal

2711P-RGK12 Antiglare Overlay for 1250H Keypad or Keypad/Touch Terminal

2711P-RGT12 Antiglare Overlay for 1250H Touch and 1250H High-Bright Touch Terminal

2711P-RGK15 Antiglare Overlay for 1500H Keypad or Keypad/Touch Terminal

2711P-RGT15 Antiglare Overlay for 1500H Touch Terminal

Cat. No. Description

2711P-RBK7 Replacement Bezel for 700H Keypad Terminal

2711P-RTK7 Replacement Bezel for 700H Touch Terminal

2711P-RBB7 Replacement Bezel for 700H Keypad or Keypad/Touch Terminal

2711P-RBK10 Replacement Bezel for 1000H Keypad Terminal

2711P-RTK10 Replacement Bezel for 1000H Touch Terminal

2711P-RBB10 Replacement Bezel for 1000H Keypad or Keypad/Touch Terminal

2711P-RBK12 Replacement Bezel for 1250H Keypad Terminal

2711P-RTK12 Replacement Bezel for 1250H Touch Terminal

2711P-RBB12 Replacement Bezel for 1250H Keypad or Keypad/Touch Terminal

2711P-RBK15 Replacement Bezel for 1500H Keypad Terminal

2711P-RTK15 Replacement Bezel for 1500H Touch Terminal

2711P-RBB15 Replacement Bezel for 1500H Keypad or Keypad/Touch Terminal
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Backlights

Miscellaneous

Adapter Plates

Cat. No. Description

2711P-RL7C Replacement Color Backlight for 700H Displays

2711P-RL10C Replacement Color Backlight for 1000H Displays

2711P-RL12C Replacement Color Backlight for 1250H Series A and B Displays

2711P-RL12C2 Replacement Color Backlight for 1250H Series C Displays

2711P-RL15C Replacement Color Backlight for 1500H Series B Displays

Cat. No. Description

2711P-RVT12 Solar Visor for Outdoor High-Bright 1250H Touch Screen Display Modules

2711P-RY2032 Replacement Battery

2711P-RTMC Mounting Clips

6189-2CONN DC, AC and 6182 Relay Connectors

Cat. No. Description

2711P-RAK7 Adapts a VersaView CE 700H Keypad Terminal to a PanelView 
Standard 900 Keypad Cutout

2711P-RAT7 Adapts a VersaView CE 700H Touch Terminal to a PanelView 
Standard 900 Touch Cutout

2711P-RAK10 Adapts a VersaView CE 1000H Keypad Terminal to a PanelView 
1000/1000E Keypad Cutout

2711P-RAT10 Adapts a VersaView CE 1000H Touch Terminal to a PanelView 
1000/1000E Touch Cutout

2711P-RAK12E Adapts a VersaView CE 1250H (or PV1000/1000E) Keypad 
Terminal to a PanelView 1200/1400E Keypad Cutout

2711P-RAT12E2 Adapts a VersaView CE 1250H (or PV1000/1000E) Touch 
Terminal to a PanelView 1200E Touch Cutout

2711P-RAT12E Adapts a VersaView CE 1250H (or PV1000/1000E) Touch 
Terminal to a PanelView 1400E Touch Cutout

2711P-RAK12S Adapts a VersaView CE 1250H (or PV1000/1000E) Keypad 
Terminal to a PanelView Standard 1400 Keypad Cutout

2711P-RAT12S Adapts a VersaView CE 1250H (or PV1000/1000E) Touch 
Terminal to a PanelView Standard 1400 Touch Cutout

2711P-RAK15 Adapts VersaView CE 1500H Keypad or Keypad & Touch 
Terminal to a PanelView 1200E/1400E Keypad Terminal

2711P-RAT15 Adapts a VersaView CE 1500H Touch Terminal to a PanelView 
1400E Touch Cutout
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Cables

Communication Adapters

Firmware Upgrade Kits

Cat. No. Description

2711P-CBL-EX04 Ethernet CAT5 Crossover Cable, Industrial Grade, 4.3 m (14 ft)

2711-NC13 RS-232 Operating Cable (9-pin D-Shell to 9-pin D-Shell), 5 m (16.4 ft)

2711-NC14 RS-232 Operating/Programming Cable (9-pin D-Shell to 9-pin D-Shell), 10 m 
(32.7 ft)

2711-NC21 RS-232 Operating Cable (9-pin D-Shell to 8-pin Mini DIN),     5 m (16.4 ft)

2711-NC22 RS-232 Operating Cable (9-pin D-Shell to 8-pin Mini DIN),   10 m (32.7 ft)

1761-CBL-AS03 DH-485 Operating Cable, 3 m (10 ft)

1761-CBL-AS09 DH-485 Operating Cable, 9 m (30 ft)

Cat. No. Description

2711P-CBL-UP02 USB to PS/2 Adapter

1761-NET-AIC AIC+ Advanced Interface Converter

1747-AIC Isolated Link Coupler with DH-485 Communication Module (2711P-RN6)

Cat. No. Description

6189-RU310 VersaView CE Media Kit includes Firmware Upgrade Wizard, 1 Firmware License, 
Certificate of Authenticity, End User License Agreement. 

6189-RUA310 VersaView CE Advanced Media Kit includes the 6189-RU310 Media Kit, PCMCIA 
to Compact Flash Adapter, and 32 MB Compact Flash Card.

6189-RUL01 Firmware Upgrade License Kit with (1) VersaView CE Firmware License. (1)

(1) Also includes Certificate of Authenticity, End User License Agreement, Installation Instructions.

6189-RUL05 Firmware Upgrade License Kit with (5) VersaView CE  Firmware Licenses. (1)

6189-RUL10 Firmware Upgrade License Kit with (10) VersaView CE  Firmware Licenses.(1) 

6189-RUL25 Firmware Upgrade License Kit with (25) VersaView CE  Firmware Licenses. (1)

6189-RUL50 Firmware Upgrade License Kit with (50) VersaView CE Firmware Licenses. (1)
Publication 6182H-UM001D-EN-P - September 2005



1-12        Overview
Publication 6182H-UM001D-EN-P - September 2005



Chapter 2

Installation

Chapter Objectives This chapter provides instructions on how to install the terminals. It 
provides information on:

• Hazardous locations

• Environment

• Enclosures

• Outdoor installation (1250H High-Bright Display only, cat. no. 
6189-RDT12H)

• Required tools

• Clearances

• Panel cutout dimensions

• Panel installation

• Product dimensions 

Hazardous Locations This equipment is suitable for: 

• Class I, Division 2, Groups A, B, C, D

• Class I, Zone 2, Group IIC

• Class II, Division 2, Groups F, G

• Class III

• or ordinary (non-hazardous) locations

The following statement applies to use in hazardous locations.

The terminals have a temperature code of T4 when operating in a 
55 °C (131 °F) maximum ambient temperature. Do not install the 
terminals in environments where atmospheric gases have ignition 
temperatures less than 135 °C (275 °F).

WARNING Explosion Hazard

• Substitution of components may impair suitability 
for hazardous locations.

• Do not disconnect equipment unless power has 
been switched off and area is known to be 
non-hazardous.

• Do not connect or disconnect components unless 
power has been switched off.

• All wiring must comply with N.E.C. articles 501, 
502, 503, and/or C.E.C. section 18-1J2 as 
appropriate.

• Peripheral equipment must be suitable for the 
location it is used in.
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USB Ports

The terminals contain two Universal Serial Bus (USB) ports which 
comply with hazardous location environments. This section details the 
field wiring compliance requirements and is provided in accordance 
with the National Electrical Code, article 500.

The USB peripheral device must be rated for use in the hazardous 
location environment in which it is used and also comply with the 
circuit parameters in Table 2.2.

The circuit parameters in Table 2.1 define the maximum voltage and 
current of the USB ports on the terminal. 

The circuit parameters in Table 2.2 define the maximum voltage, 
current, capacitance, and inductance values for any peripheral device 
connected to a VersaView CE USB port in a hazardous location 
environment.

Table 2.1 VersaView CE USB Port Circuit Parameters

Parameter Value Parameter Definition

Voc 5.25V dc Open circuit voltage of the host USB port.

Isc 1.68 A Maximum output current of the host USB port.

Table 2.2 Required Circuit Parameters for the USB Peripheral Device

Parameter Value Parameter Definition and Application Requirement

Vmax 5.25V dc Maximum applied voltage rating of the USB peripheral device.  
Vmax shall be greater than or equal to Voc in Table 2.1 (Vmax  ≥ Voc ).

Imax 1.68 A Maximum current to which the USB peripheral device can be 
subjected.  I max shall be greater than or equal to Isc in Table 2.1   
(Imax  ≥  Isc).

Ca 10 µF Maximum allowed capacitance of the USB peripheral device and its 
associated cable. The sum of Cint   of the USB peripheral device and 
Ccable of  the associated cable shall be less than or equal to Ca   
 (Cint +  Ccable  ≤ Ca). 

La 15 µH Maximum allowed inductance of the USB peripheral device and its 
associated cable. The sum of Lint  of the USB peripheral device and 
Lcable  of the associated cable shall be less than or equal to La    
 (Lint +  Lcable  ≤ La).

USB 
Peripheral

Device

VersaView CE Terminal
Associated Nonincendive Field

Wiring Apparatus

USB Ports
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Application Information

Per the National Electrical Code, the circuit parameters of associated 
field wired apparatus for use in hazardous locations shall be 
coordinated with the host product such that their combination 
remains nonincendive. The VersaView CE device and the USB 
peripheral device shall be treated in this manner.

The circuit parameters of the VersaView CE USB ports are given in 
Table 2.1. The USB peripheral device and its associated cabling shall 
have circuit parameters with the limits given in Table 2.2 for them to 
remain nonincendive when used with the VersaView CE USB ports. If 
cable compliance and inductance are not known, use the following 
values from UL 913:

Ccable = 60 pF/ft

Lcable = 0.20 µH/ft

Environmental 
Considerations

The terminals are suitable for use in an industrial environment when 
installed in accordance with these instructions. Specifically, this 
equipment is intended for use in clean, dry environments (Pollution 

Degree 2)(1) and with circuits not exceeding Over Voltage Category 

II(2) (IEC 60664-1).(3)

(1) Pollution Degree 2 is an environment where, normally only non-conductive pollution occurs except that 
occasionally a temporary conductivity caused by condensation shall be expected.

(2) Over Voltage Category II is the load level section of the electrical distribution system. At this level transient 
voltages are controlled and do not exceed the impulse voltage capability of the product’s insulation.

(3) Pollution Degree 2 and Over Voltage Category II are International Electrotechnical Commissions (IEC) 
designations.

Enclosures The terminals must be mounted in a panel or enclosure to protect the 
internal circuitry. The terminals meet IP54, IP65 and NEMA Type 
12/13 and 4X (indoor) ratings only when mounted in a panel or 
enclosure with the equivalent rating. When the terminal is not 
mounted in a panel, it is not secure or safe for operation. You must 
comply with NEMA Type 4X (indoor) requirements for environmental 
specifications. 

For more enclosure and certification information on the Outdoor 
High-Bright display module, refer to publication 2711P-IN026.  
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Outdoor Installation 
(cat. no. 6189-RDT12H only)

When using the High-Bright display module outdoors, important 
considerations in maximizing the field life of the front bezel and 
display are: 

• Selecting proper enclosure

• Orientation of the terminal

Both ultraviolet and infrared radiation can reduce the field life of any 
electronic device. While the materials used in the terminal bezels 
provide long field life, that life can be improved by proper installation.

Ultraviolet radiation from the sun causes all plastics to fade or yellow 
and become brittle over time. Using an antiglare overlay, cat. no. 
2711P-RGT12, will protect the front of the terminal from direct 
exposure to UV radiation and greatly increase its field life.

When installing the High-Bright display module in an environment 
where the front of the terminal will be in direct sunlight during the 
hottest part of the day and the external ambient temperature can 

exceed 40 °C (104 °F), use the visor kit, cat. no. 2711P-RVT12. The 
visor reduces the solar load on the front of the display and helps to 
maintain internal temperatures within specification.

The High-Bright display module has a built in temperature sensor that 
automatically reduces the backlight intensity if the temperature inside 

the cabinet exceeds 55 °C. This reduces the risk of damage to the 
display. 

The paint color, size, and power dissipated by the internal 
components of an enclosure affect the temperature rise inside the 
cabinet. Hoffman, a Rockwell Automation Encompass Partner, has 
information to assist you with enclosure selection and heating/cooling 
accessories to meet the temperature requirements of the installed 
equipment. See website http://www.hoffmanonline.com.

Stirring fans or active cooling may be required in high altitude and 
high ambient temperature locations to keep the internal enclosure 

temperature below 55 oC (131 °F). Use a heater in installations where 

the ambient temperature is below 0 oC (32 oF).

The backlight of the high-bright display generates a significant amount 
of heat when set to full intensity. To minimize the amount of heat 
generated and extend the life of the backlight, decrease the display 
intensity by using the screen saver with a 5 to 10 minute delay. 

Avoid placing the terminal on the south (north in the southern 
hemisphere) or west side of the cabinet, if possible. This will reduce 
the heat rise due to solar loading during the hottest part of the day.
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Mount the terminal vertically to minimize solar loading on the display.  
Do not mount the terminal in a sloped enclosure if it will be exposed 
to direct sunlight.

Required Tools • Panel cutout tools

• Small, slotted screw driver

• Torque wrench (in-lb)

Clearances Allow adequate clearance around the terminal, inside the enclosure, 
for adequate ventilation. Consider heat produced by other devices in 
the enclosure. The ambient temperature around the terminals must be 
between 0 to 55 °C (32 to 131 ºF).

Minimum clearances for ventilation are:

• Top clearance: 51 mm (2 in)

• Bottom clearance: 102 mm (4 in)

• Side clearances: 25 mm (1 in)

• Back clearance: 25 mm (1 in)

Minimum side clearance for insertion of memory card is 102 mm  
(4 in). 

Cutout Dimensions The table lists the panel cutout dimensions for each terminal. Use the 
full size template shipped with your terminal to mark the cutout 
dimensions. 

VersaView CE Terminals Height mm (in) Width mm (in)

VersaView CE 700H Keypad or Keypad & Touch 167 (6.57) 264 (10.39)

VersaView CE 700H Touch 154 (6.08) 220 (8.67)

VersaView CE 1000H Keypad or Keypad & Touch 224 (8.8) 375 (14.75)

VersaView CE 1000H Touch 224 (8.8) 305 (12.00)

VersaView CE 1250H Keypad or Keypad & Touch 257 (10.11) 390 (15.35)

VersaView CE 1250H and 1250H High-Bright Touch 257 (10.11) 338 (13.29)

VersaView CE 1500H Keypad or Keypad & Touch 305 (12.00) 419 (16.50)

VersaView CE 1500H Touch 305 (12.00) 391 (15.40)
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Mount the Terminal in a 
Panel

Mounting clips secure the terminal to the panel. The number of clips 
you use (4, 6 or 8) varies by terminal type.
 

1. Cut an opening in the panel using the panel cutout shipped with 
the terminal.

2. Make sure the terminal sealing gasket is properly positioned on 
the terminal. 

This gasket forms a compression type seal. Do not use sealing 
compounds.

3. If using keypad legend strips on keypad terminals, we 
recommend that you install the strips before installing the 
terminal. 

Be careful not to pinch the legend strip during installation.

4. Place the terminal in the panel cutout.

ATTENTION • Disconnect all electrical power from the panel 
before making the panel cutout.

• Make sure the area around the panel cutout is 
clear.

• Take precautions so metal cuttings do not enter 
any components already installed in the panel.

• Failure to follow these warnings may result in 
personal injury or damage to panel components.

Sealing Gasket
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5. Slide the ends of the mounting clips into the slots on the 
terminal.

6. Tighten the mounting clip screws by hand until the gasket seal 
contacts the mounting surface uniformly. 

7. Tighten the mounting clips screws to a torque of 0.90 to 1.1 Nm 
(8 to 10 in-lb) using the specified sequence. Do not over-tighten.

Mounting Clip Slot
Mounting Clip

ATTENTION Tighten the mounting clips to the specified 
torque to provide a proper seal and to prevent 
damage to the product. Allen-Bradley assumes 
no responsibility for water or chemical damage 
to the product or other equipment within the 
enclosure because of improper installation.

1

2

3

4

5

6

7

8 Torque Sequence 
6 Clips

24 6

51 3
Torque Sequence

4 Clips

1 4

3 2

 Torque Sequence  
8 Clips
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Product Dimensions Product dimensions for each terminal are in mm (in). 

Depth dimensions are shown for: 

• Base configured unit (display module and logic module) 

• Base configured unit with communication module 

VersaView CE 700H

700H Touch Screen Terminal

179 
(7.04)

246 
(9.68)

290 
(11.40)

193
(7.58)

a 55 (2.18) Display to Logic Module
b 83 (3.27) Display to Communication Module

a 55 (2.18) Display to Logic Module
b 83 (3.27) Display to Communication Module

b

a

a

b

700H Keypad or Keypad & Terminal
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VersaView CE 1000H

Depth dimensions are shown for: 

• Base configured unit (display module and logic module) 

• Base configured unit with communication module 

329 
(12.97)

248 
(9.77)

399 
(15.72)

248 
(9.77)

a 55 (2.18) Display to Logic Module
b 83 (3.27) Display to Communication Module

a 55 (2.18) Display to Logic Module
b 83 (3.27) Display to Communication Module

b

a

a

b

1000H Keypad or Keypad & Touch Terminal

1000H Touch Screen Terminal
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VersaView CE 1250H

Depth dimensions are shown for: 

• Base configured unit (display module and logic module) 

• Base configured unit with communication module 

282 
(11.12)

416 
(16.36)

363
(14.30)

282 
(11.12)

a 55 (2.18) Display to Logic Module
b 83 (3.27) Display to Communication Module

a 55 (2.18) Display to Logic Module
b 83 (3.27) Display to Communication Module

a
b

a
b

1250H Keypad or Keypad & Touch Terminal

1250H Touch Screen Terminal

a 74 (2.90) Display to Logic Module
b 101 (3.99) Display to Communication Module

1250H High-Bright 

1250H

b a
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VersaView CE 1500H

Depth dimensions are shown for: 

• Base configured unit (display module and logic module) 

• Base configured unit with communication module 

1500H Touch Screen Terminal

330 
(12.97)

419 
(18.46)

416 
(16.37)

330
(12.97)

a 65 (2.55) Display to Logic Module
b 93 (3.65) Display to Communication Module

a 65 (2.55) Display to Logic Module
b 93 (3.65) Display to Communication Module

ab

ab

1500H Keypad or Keypad & Touch Terminal
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Chapter 3

Connect Power

Chapter Objectives This chapter covers wiring and safety guidelines, and provides 
information on how to:

• Remove and install the terminal block

• Connect DC power

• Connect AC power

• Reset the terminal

Wiring and Safety 
Guidelines

Use publication NFPA 70E, ‘Electrical Safety Requirements for 
Employee Workplaces’, IEC 60364 ‘Electrical Installations in Buildings’ 
or other applicable wiring safety requirements for the country of 
installation when wiring the devices. In addition to the NFPA 
guidelines:

• Connect the device and other similar electronic equipment to its 
own branch circuit.

• Protect the input power by a fuse or circuit breaker rated at no 
more than 15 A.

• Route incoming power to the device by a separate path from the 
communication lines.

• Cross power and communication lines at right angles if they 
must cross.

Communication lines can be installed in the same conduit as 
low level DC I/O lines (less than 10V).

• Shield and ground cables appropriately to avoid Electromagnetic 
Interference (EMI).

Grounding minimizes noise from EMI and is a safety measure in 
electrical installations. 

For more information on grounding recommendations, refer to the 
National Electrical Code published by the National Fire Protection 
Association of Boston.

For additional information on terminal wiring and grounding 
applications, refer to publication 2711P-TD001. You can locate this 
publication in the literature library at:

 www.rockwellautomation.com/literature
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Remove and Install the 
Power Terminal Block

You can remove and reinstall the power terminal block for ease of 
installation, wiring, and maintenance. The terminals ship with the 
power block installed.

The terminals operate only on DC power.

• Series A-D logic modules use a 3-position terminal block.

• Series E or later logic modules use a 2-position terminal block.

WARNING Explosion Hazard
• Substitution of components may impair suitability 

for hazardous locations.

• Do not disconnect equipment unless power has 
been switched off and area is known to be 
non-hazardous.

• Do not connect or disconnect components unless 
power has been switched off.

• All wiring must comply with N.E.C. articles 501, 
502, 503, and/or C.E.C. section 18-1J2 as 
appropriate.

• Peripheral equipment must be suitable for the 
location it is used in.

ATTENTION Disconnect all power before installing or replacing 
components. Failure to disconnect power may result 
in electrical shock and/or damage to the terminal.

1. Loosen the two screws 
that secure the terminal 
block.

2. Gently pull the terminal 
block away from the 
connector.  

1. Reattach the terminal block to 
the connector until seated.

2. Tighten the two screws that  
secure the terminal block  
to the connector.

To remove terminal block:

To install terminal block:

3-Position Terminal Block

2-Position Terminal Block
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DC Power Connections Terminals that operate on 24V dc power are EN 61131-2 Equipment 
Class II devices. These terminals have an integrated, non-isolated,  
24V dc power supply. The electrical input ratings are:

•  24V dc nominal (18 to 32V dc)

• 70 W maximum (2.9A @ 24V dc)

The power supply is internally protected against reverse polarity of 
the + and - connections. Connecting the DC positive (+) or  
DC negative (-) source to the Functional Earth (FE) may damage the 
terminal.

The input power terminal block on the integrated power supply is 
removable and supports these wire sizes.

The non-isolated power supply does not provide galvanic isolation. A 
Class 2 Safety Extra-Low Voltage (SELV) isolated power supply with a 
24V dc nominal output voltage is required to power the terminal. 

Terminal Wire Type Dual Wire Gauge(1) Single Wire Gauge Terminal Screw Torque

Logic module, Series A-D Stranded or solid #22…#16AWG #22…#14 AWG 0.23…0.34 Nm 
(2…3 in-lbs)

Logic module, Series E and later Stranded or solid #22…#16AWG #22…#14 AWG 0.45…0.56 Nm 
(4…5 in-lbs)

(1) Two-wire maximum per terminal

ATTENTION Use a Class 2 SELV isolated and ungrounded 
power supply as input power to the terminal. This 
power source provides protection so that under 
nominal and single fault conditions, the voltage 
between conductors and between conductors and 
Functional Earth or Protective Earth does not 
exceed a safe value.
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Functional Earth Connection

DC powered terminals have a Functional Earth (FE) terminal which 
you must connect to a low impedance earth ground. This connection 
is required for Electromagnetic Compliance (EMC) with the European 
Union (EU) EMC directive for CE-mark conformance.

The Functional Earth ground connection is on the back of the display 
module near the bottom.

The Functional Earth terminal wiring requires a minimum wire gauge.

The Functional Earth terminal may be internally connected to the DC 
negative (- DC) terminal within the VersaView CE terminal.

Use a single dedicated 24V dc source (power supply) to power each 
terminal, such as cat. no. 2711P-RSACDIN. Using a separate, isolated 
and ungrounded SELV source to power each terminal, prevents 
ground loop currents from damaging the terminals.

The terminals contain isolated and non-isolated communication ports. 
Refer to Chapter 7 for information on Communication Port Isolation.

Terminal Wire Type Wire Gauge Terminal Screw Torque

700-1500 Stranded or solid #14…#10 AWG 1.13…1.36 Nm (10…12 in-lbs)

ATTENTION A ground loop can occur when a voltage potential 
exists between two separate ground points. Make 
sure that the terminal does not serve as a conductive 
path between ground points at different potentials.

IMPORTANT For more information on wiring and grounding the 
terminals, refer to publication 2711P-TD001.
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Connect DC Power

1. Disconnect power to the terminal. 

2. Secure the DC power wires to the terminal block screws. 

Follow the markings on terminal blocks and terminal for proper 
connections.

3. Secure the Functional Earth ground wire to the Functional Earth 
ground terminal screw at the bottom of the display.

4. Apply 24V dc to the terminal.

WARNING Explosion Hazard - Do not connect or disconnect 
equipment while circuit is live unless area is known 
to be non-hazardous. 

Disconnect all power before installing or replacing 
components. Failure to disconnect power may result 
in electrical shock and/or damage to the terminal.

Logic Module with 
DC Power Input

+   DC Positive

-   DC Negative
     Functional  Earth Ground

2-Position Terminal Block 
Series E or later Logic Modules

3-Position Terminal Block 
Series A-D Logic Modules

+– – +
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AC Power Connections Terminals that operate on AC power are EN 61131-2 Equipment  
Class I devices. Connecting a 700-1500 terminal to AC power requires 
a separate power supply, cat. no. 2711-RSACDIN, which mounts to a 
DIN Rail. This power supply converts AC power to DC power and has 
these electrical input ratings:

• 85 to 264 V ac (47 to 63 Hz)

• 120 VA maximum

For more information, refer to the installation instructions shipped 
with the power supply.

Reset the Terminal All terminals have a Reset switch and a Default switch on the side of 
the logic module. They are used to restart the terminal.

Reset

Use the Reset switch to restart the terminal without having to 
disconnect and reapply power.Insert a thin, nonconductive probe into 
the hole marked Reset and press the switch. The terminal performs a 
series of startup tests and opens the CE desktop or RSView ME 
depending on how the terminal is used and configured.

Reset Default 
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Default

Use the Default switch with the Reset switch to start the terminal in 
Safe Mode. This is a diagnostics mode where the system is reduced to 
a known state that allows recovery from a software problem. Safe 
Mode ignores all user changes to the system and avoids any problem 
that is due to interactions with end-user software or changes.

For more details on Safe Mode, refer to Chapter 9 on Troubleshooting.

1. Insert a thin, nonconductive probe into the hole marked Default 
and press the switch.

2. Insert the probe into the hole marked Reset and press the 
switch. The system will restart immediately into the Safe Mode.

ATTENTION Use a nonconductive thin probe to press the Reset 
and Default switch. Do not use a conducting object 
such as a paper clip or you may damage the 
terminal. Do not use the tip of a pencil; graphite 
may damage the terminal. 
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Chapter 4

Use RSView ME Station

Chapter Objectives This chapter shows how to use RSView ME Station on your terminal. It 
includes topics on how to:

• Configure startup options

• Start RSView ME Station

• Load an ME application

• Run an ME application

• View application settings

• Modify terminal settings

Startup Options for RSView 
ME Station

RSView ME Station can start:

• without loading or running an .MER application.

• automatically loading an .MER application.

• automatically loading and running an .MER application.

Start RSView without Loading or Running .MER Application

To start RSView ME Runtime without loading or running an .MER 
application, do one of the following:

• Open the RSView ME Station icon from the desktop

• Select RSView ME Station from the Start menu

Programs>Rockwell Software>RSView ME Station

• Type MERuntime.exe and its path in the Run dialog of the 
Windows Start menu.

Path to MERuntime.exe

If the path to RSView ME contains spaces, you must enclose the 
path in double quotes.

If you copy the RSView ME Station shortcut from the desktop to the 
Windows Startup folder (\Storage Card\Windows\Startup), RSView 
ME station will automatically run on startup.

Example:
"Storage Card\Rockwell\Software\RSViewME\MERuntime.exe" 
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Start RSView and Load .MER Application

To start RSView ME Station and automatically load an .MER 
application, type the appropriate shortcut path in the Run dialog on 
the Windows Start menu.

Path to MERuntime.exe, followed by a space, followed by the path 
to the .MER 

If the path to RSView ME or the path to the application contains 
spaces, you must enclose the path in double quotes.

If you place a shortcut to the .MER application into the Windows 
Startup (\Storage Card\Windows\Startup) folder, the ME Runtime will 
automatically start and load the .MER application on terminal startup.

If the application specified in the Run dialog or the Startup folder does 
not exist or is corrupted, the main RSView ME Configuration Mode 
screen will open.

Start RSView and Run .MER Application

To start RSView ME Station and automatically run an .MER application:

• In RSView Studio, select Tools>Transfer Utility and select Run 
application when download completes on the Download tab.

• type the appropriate shortcut path in the Run dialog on the 
Windows Start menu.

Path to MERuntime.exe, followed by a space, followed by the path 
to the .MER, followed by /r

If the path to RSView ME or the path to the application contains 
spaces, you must enclose the path in double quotes.

If you place a shortcut with the above command line in the Windows 
Startup folder (\Storage Card\Windows\Startup), the ME Runtime will 
start and automatically run the .MER application.

If the application specified in the Run dialog or the Startup folder does 
not exist or is corrupted, the main RSView ME Configuration Mode 
screen will open and display the following message:

Unable to load application

Example:
"Storage Card\Rockwell\Software\RSViewME\MERuntime.exe"  "Storage Card\Rockwell\Software\RSViewME\Runtime\MYAPP.MER" 

Example:
"Storage Card\Rockwell\Software\RSViewME\MERuntime.exe"  "Storage Card\Rockwell\Software\RSViewME\Runtime\MYAPP.MER" /r
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Other Shortcut Paths for RSView ME Station

• To run the .MER application and delete its log files without 
replacing the terminal’s communication configuration with that 
of the applications, use the following path:

Path to MERuntime.exe, followed by a space, followed by the path 
to the .MER, followed by /r/d

• To run the .MER application and replace the terminal’s 
communication configuration with that of the applications 
without deleting its log files, use the following path:

Path to MERuntime.exe, followed by a space, followed by the path 
to the .MER, followed by /r/o

• To run the .MER application, delete its log files, and replace the 
terminal’s communication configuration with that of the 
applications, use the following path:

Path to MERuntime.exe, followed by a space, followed by the path 
to the .MER, followed by /r/d/o

IMPORTANT If the path to RSView ME or the path to the 
application contains spaces, you must enclose the 
path in double quotes.

Example:

"Storage Card\Rockwell\Software\RSViewME\MERuntime.exe"  "Storage Card\Rockwell\Software\RSViewME\Runtime\MYAPP.MER" /r/d

Example:

"Storage Card\Rockwell\Software\RSViewME\MERuntime.exe"  "Storage Card\Rockwell\Software\RSViewME\Runtime\MYAPP.MER" /r/o

Example:

"Storage Card\Rockwell\Software\RSViewME\MERuntime.exe"  "Storage Card\Rockwell\Software\RSViewME\Runtime\MYAPP.MER" /r/d/o
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Start RSView ME from the 
desktop

If RSView ME Station does not automatically run on startup, you can 
access it from the Windows Start menu or the desktop icon.   

To start RSView ME Station:

• Select RSView ME Station from the Windows Start menu.

Start>Programs>Rockwell Software>RSView ME Station

• Select the RSView ME Station icon on the desktop.

To access RSView ME Station from a running application:

• Press the Goto Configuration Mode button.

This button is added to application screen in RSView Studio.

The application stops running but is still loaded.

To activate buttons:

• on keypad terminals, select the 
corresponding function key [Fx]

• on touch screen terminals, tap the 
button with your finger or stylus.

• if a mouse is attached, make 
selections with the mouse.

Name of application that is currently loaded. 
Only appears if application is loaded.

Main Screen Button Description

Load Application (F1) Opens another screen where you select an application to load. 
Once loaded, the application name will appear under Current 
Application.

Run Application (F2) Runs the .MER application displayed under Current Application. 
An application must be loaded before you can run it.

Application Settings (F3) Opens a menu of application-specific configuration settings.

Terminal Settings (F4) Opens a menu of options to configure non-application, specific  
terminal settings for the VersaView CE terminal.

Delete Log Files Before 
Running (F5)

Toggles between Yes and No. If you select Yes, all data log files, 
alarm history and alarm status files will be deleted before the 
application runs. If you select No, log files are not deleted. 

Reset (F7) Resets the terminal. The action that occurs on startup depends 
on whether shortcut paths are defined in the Windows Startup 
folder.

Exit (F8) Exits RSView ME Station.
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Screen Buttons

RSView ME Station uses screen buttons for data entry and navigation.

• On terminals with a touch screen, tap the button with your 
finger or stylus.

• On terminals with a keypad, select the function key listed on the 
button, or in some cases, the corresponding key on the keypad. 

Besides operation specific buttons which are used to modify 
configuration data, most screens have a combination of these buttons.

Screen Buttons Description

Returns to the previous screen.

Accepts modified values and returns to 
previous screen.

Cancels the current operation without 
saving any changes.

Moves highlight up or down a list.

Selects a highlighted screen or item from a 
list. 

Close
[F8]

OK
[F7]

Cancel
[F8]
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Input Panel
Many screens have buttons that access fields where you must 
enter/edit data. When you press the button or function key, the Input 
Panel opens ready for you to input data.

If the field is restricted to a numeric value, only the 0-9 keys will be 
enabled. If the value is an IP address, the 0-9 and decimal point keys 
will be enabled. All other keys will be disabled.

To enter characters in the Display Area:

1. Select a character on the Character Keyboard. 

2. Press the Select button to copy the character to the Display 
Area.

3. When done entering all characters, press Enter. You will return 
to the previous screen.

You will return to the previous screen with the newly entered data.

Display Area

Character Keyboard

Controls

• On a touch terminal, tap the keys.

• On a keypad terminal, use the 
arrow keys on the keypad to 
select keys.

• If a mouse is attached, use the 
mouse to select keys. 

Controls Function

SHF Switches keys between their shifted and unshifted state. The initial default is shifted.

CAPS Switches keys between lowercase and uppercase characters. The initial default is lowercase.

SPACE Enters a space between characters in the Display Area.

Backspace Deletes the previous character (to the left of the cursor) in the Display Area.

Select Selects a character and enters it in the Display Area.

Arrows Selects the character to the left, right, above or below the currently selected character.

Enter Accepts the entered characters and returns to the previous screen

ESC Cancels the current operation and returns to the previous screen.
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Load an ME Application To load an RSView ME .MER application, select the Load Application 
button on the main screen.

1. Select the Source button to select the storage location of the 
application file you want to load. The options are: 

• Internal Storage - the Internal Compact Flash in the terminal

• External Storage 1 - the External Compact Flash card loaded in 
the card slot of the terminal 

• External Storage 2 - for future use

2. Select an .MER file from the list. Use the up and down cursor 
keys to select a file. 

3. Select the Load button to load the application.

You will be asked if you want to replace the terminals’ current 
communication configuration with the application’s 
communication configuration. 

4. Select Yes or No. If you select Yes, any changes made to the 
device addresses or driver properties in the RSLinx 
Communications screen will be lost.

The name of the currently loaded application will appear at the top of 
the main RSView ME Station screen.

Moves 

Moves 

List of .mer applications 
stored in the compact 
flash of the terminal.

TIP RSView ME only recognizes files located in the 
\RockwellSoftware\RSViewME\Runtime\ 
folder.
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Run an Application To run a loaded application, select the Run Application button on the 
main RSView ME Station screen. An application must be loaded, 
before you can run it. Log files generated by the application may be 
deleted if this option was selected on the main screen or enabled as a 
Startup Option under Terminal Settings.

Application Settings From the Application Settings screen, you can show device shortcuts 
defined for the loaded .MER application. For example, your .MER 
application might have SLC defined as a device shortcut name for the 
SLC 5/05. Device shortcuts are read-only and cannot be edited.

Terminal Settings From Terminal Settings, you can open screens to configure and 
modify non-application settings for the terminal.

Moves highlight up

Moves highlight down

Selects highlighted 
item and opens screen

• On a touch terminal, tap the 
button.

• On a keypad terminal, press 
the corresponding key on the 
keypad

Returns to previous 
screen.

Diagnostics Setup
Display
File Management
Font Linking
Input Devices
Networks and Communications
Print Setup
Startup Options
System Event Log
System Information
Time/Date/Reg 

Networks and Communications

Terminal Setting Description

Diagnostic Forwards diagnostic messages form a remote log 
destination to a computer running diagnostics.

Display Shows the temperature of the display, sets the intensity of 
the backlight, and enables/disables the screen saver.

File Management Copies or deletes application files or font files from a 
storage location.

Font Linking Links a font file to a base font loaded on the terminal.

Input Devices Configures settings for the keypad, touch screen, or 
attached keyboard and mouse.

Networks and Communications Configures network connections and communication 
settings specific to the application (DHPlus, DH485, 
Remote I/O, ControlNet, DeviceNet, Serial).

Print Setup Configures settings for printing displays, alarm messages, 
and diagnostics messages generated by the application.
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Networks and 
Communications

From the Networks and Communications screen, you can access 
settings for:

• KEPServer Serial Port ID’s

• Network Connections

• RSLinx Enterprise Communications

KEPServer Serial Port ID’s

To access the KEPServer Serial Port ID’s screen, you must have 
KEPServer Enterprise installed on your terminal. Otherwise, you will 
get an error message when accessing this screen. If you plan on using 
KEPServer Enterprise and serial communications, you must specify 
which COM port to use.

Startup Options Specifies whether the terminal starts up in configure or 
run mode. Also lets you enable/disable tests to run on the 
terminal at startup.

System Event Log Displays a list of system events currently logged by the 
terminal. 

System Information Displays power, temperature, battery and memory details 
for the terminal. Also shows the firmware number for 
RSView ME and technical support information.

Time/Date/Regional Settings Sets the date, time, language and numeric format used by 
the terminal and applications. 

Terminal Setting Description

Terminal Settings

Networks and Communications

KEPServer Serial Port ID’s
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RSLinx Enterprise Communications

The RSLinx Enterprise Communications screen shows a treeview of 
installed communication cards and network configurations. You can:

• edit or view the driver settings for the communication protocol 
used by your .MER application.

• edit the device address of the controller on the network.

The procedure for editing these settings is the same regardless of the 
communication protocol. The only differences are the properties for 
each communication protocol and the device address of the logic 
controller. The properties for each communication protocol are 
defined immediately after this section.

Terminal Settings

Networks and Communications

RSLinx Enterprise Communications

Communication Driver

Ethernet Driver
Has no properties to edit.
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To edit communication settings:

1. From the RSLinx Configuration Screen, select the communication 
card installed on your terminal.

2. Select the Driver Settings button.

A properties screen opens showing the current communication 
settings for the driver. 

3. To modify a setting, select the setting and then the Edit button. 
The Input Panel opens showing the current setting. 

4. Using the Input Panel, modify the setting and then select the 
Enter button.

You return to the previous screen with the newly entered data.

To edit the device address of the logic controller:

1. From the RSLinx Configuration screen, select a device node.

2. Select the Edit Device button.

A screen opens showing the name of the device and its current 
node address. 

3. To modify the device address, press the Device Address button. 
The Input Panel opens showing the current address. 

4. Using the Input Panel, modify the address and then select the 
Enter button.

You return to the previous screen with the new address.

IMPORTANT Modified settings do take effect until the terminal is 
rebooted. 
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DHPlus Properties

The DHPlus Properties screen lets you view or modify settings for a 
terminal connected to a DHPlus network. 

DH485 Properties

The DH485 Properties screen lets you view or modify settings for a 
terminal connected to a DH-485 network.

Remote I/O Properties

The RIO Properties screen configures communication settings for a 
terminal on a Remote I/O link.

Field Description Valid Values

Jumper ID Identifies the communication card if multiple 
cards are installed on terminal.

0 - 3

Station Number The unique address of the terminal on the 
DHPlus network.

0 - 77 (octal)

Baud Rate The baud rate of the DHPlus network. 57600 (default)
115200
230400

Field Description Valid Values

Jumper ID Identifies the communication card if multiple 
cards are installed on terminal.

0 - 3

Station Number The unique station number of the terminal on 
the DH-485 network.

0 - 31 (decimal)

Baud Rate The baud rate of the DH-485 network. 9600
19200

MaxStationNumber The maximum station number on the DH-485 
network. The value must be greater than or 
equal to the Station Number.

0-31 (decimal)

Field Description Valid Values

Jumper ID Identifies the communication card if multiple 
cards are installed on terminal.

0 - 3

Baud Rate The baud rate of the Remote I/O network. 57600 (default)
115200
230400
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ControlNet Properties

The ControlNet Properties screen configures communication settings 
for the terminal on a ControlNet network.

DeviceNet Properties

The DeviceNet Properties screen configures communication settings 
for the terminal on a ControlNet network.

Serial Properties

The Serial Properties screen configures settings for serial 
communications (using the RS-232 serial port) on the terminal.

Field Description Valid Values

Device ID Unique address of the PanelView Plus 
terminal on the ControlNet network.

1 - 99

Field Description Valid Values

MacID Unique address of the terminal on the 
DeviceNet network.

0 - 63

Baud Rate The baud rate at which the DeviceNet driver 
communicates.

125K (default)
250K
500K

Field Description Valid Values

Device The serial device your terminal is connected 
to.

PLC_CH0
KF2
SLC_CH0
KF3
KFC
KFC15
AC_CH0

Error Check Type of error checking used. Error checking is 
automatically configured if Use Auto Config 
is set to Yes.

BCC, CRC

Parity Type of parity used. The parity is 
automatically configured if Use Auto Config 
is set to Yes.

None, Odd, Even

Stop Bits Number of stop bits used. 1 or 2

Ack Timeout Ack/Poll timeout value in milliseconds. 20 - 60,000 ms

Max Retries Maximum number of retries before the serial 
driver fails.

0 - 255
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Station Station number based on a specific device. PLC_CH0 0-77 (octal)
KF2 0-77 (octal)
SLC_CH0 0-31
KF3 0-31
KFC 1-99
KFC15 1-99
AC_CH0 0-255

Baud Rate Data rate at which serial driver 
communicates. The baud rate is 
automatically configured if Use Auto Config 
is set to Yes.

110, 300, 600, 1200, 4800 
9600, 19200, 38400, 115200

Use Auto Config Automatically or manually configures the 
baud rate, parity and error checking 
parameters.

Yes (auto configure)
No (manual configure)

Com Port Communication port used on the terminal. 1 (COM1)
2 (COM2)

Field Description Valid Values
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Network Connections

The Network Connections screen lets you configure these items for 
the terminal:

• Device Name

• Network Adapters

• Network Identification

Device Name

The Device Name screen identifies the terminal to other computers on 
the network. 

Field Description Valid Values

Device Name (1)

(1) Check with your network administrator to determine a valid device name.

Name that identifies the terminal to other 
computers on the network.

1 to 15 characters
A leading character in the 
range ’a - z’ or  ’A - Z’
Remaining characters in the 
range ’a - z’, ’A - Z’, ’0 - 9’, or 
’- ’ (hyphen)

Device Description Provides a description of the terminal. 50 characters maximum

Terminal Settings

Networks and Communications

Network Connections

Terminal Settings

Networks and Communications

Network Connections

Device Name
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Network Adapters

The Network Adapters screen configures driver settings for all 
network adapters installed on the terminal. The only network adapter 
on the terminal is the Built-in Ethernet Controller.

Press the Name Servers button and/or IP Address button to access 
driver settings.

Name Servers
Defines Name Server addresses for the Network Adapter. These 
addresses are automatically assigned if DHCP is enabled for the 
network adapter. 

Field Description Valid Values

Primary DNS The address of the primary DNS resolver. xxx.xxx.xxx.xxx

Secondary DNS The address of the secondary DNS resolver. xxx.xxx.xxx.xxx

Primary WINS The address of the primary WINS resolver. xxx.xxx.xxx.xxx

Secondary WINS The address of the secondary WINS resolver. xxx.xxx.xxx.xxx

Terminal Settings

Networks and Communications

Network Connections

Network Adapters

E100CE1:Built-in Ethernet Controller 
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IP Address

The IP Address screen identifies the IP address of the selected 
network adapter. If the network the terminal is connected to does not 
automatically assign an IP address, you can assign the address in this 
screen.

Field Description Valid Values

Use DHCP Enables or disables DHCP (Dynamic Host 
Configuration Protocol) settings. DHCP 
automatically allocates network devices and 
configurations to newly attached devices on 
the network.

If DHCP is set to Yes, the terminal is 
automatically assigned an IP address, Subnet 
Mask and Gateway. The fields are disabled.

If DHCP is set to No, you can enter the IP 
address, Subnet Mask and Gateway address.

Yes (default)
No

IP Address A unique address identifying the terminal on 
the Ethernet network.

xxx.xxx.xxx.xxx
000.000.000.000 (default)
Range of values for the first 
set of decimal numbers is 
1-255 unless all fields are set 
to 000. The range of values for 
the last three sets of decimal 
numbers is 0-255.

Subnet Mask Address must be identical to the server 
subnet mask.

xxx.xxx.xxx.xxx

Gateway Optional Gateway address xxx.xxx.xxx.xxx

Mac ID Read only field
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Network Identification

The Network Identification screen configures settings that enable the 
terminal to gain access to network resources. You can enter a user 
name, password and domain (provided by your network 
administrator).
 

Field Description Valid Values

User Name Identifies the user to the network. 70 characters maximum

Password Characters that gain access to network along 
with the user name.

No character limitation

Domain Name Provided by network administrator. 15 characters maximum

Terminal Settings

Networks and Communications

Network Connections

Network Identification
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Diagnostic Setup The Diagnostic Setup screen configures diagnostics for the current 
computer. The screen shows a treeview of possible diagnostic nodes.
  The Remote Log Destination forwards messages that it receives to a 

Windows 2000/XP computer running diagnostics. The location is 
determined by the IP address and port number.
 

Message Routing
The Message Routing screen lets you access these screens:

• Remote Log

• RSView Diagnostics List

Each of the above screens shows a list of messages that can be sent to 
that destination. The list shows the On/Off status of each message 
type. Use the On/Off button to turn a message type on or off. A 
message type is enabled if it has a checked box.

To access the Remote 
Log Setup or Message 
Routing, select the node 
and then the Edit button.

Terminal Settings

Diagnostic Setup

Field Description Valid Values

Address Address of the remote Windows 2000/XP 
computer.

xxx.xxx.xxx.xxx

Port The port used to communicate with the 
remote Windows 2000/XP computer. 

4445 (default)
Publication 6182H-UM001D-EN-P - September 2005



4-20        Use RSView ME Station
File Management The File Management screen lets you access screens to:

• Delete Files

• Copy Files

Delete Files

From the Delete Files screen you can select options to:

• Delete Applications - deletes an .MER application file from a 
storage location. 

• Delete Fonts - deletes a font file from a storage location.

• Delete Log Files - deletes any data log files, alarm history files 
and alarm status files in the System Default location on the 
terminal.

Delete Application or Font Files

The process for deleting an application file or a font file is the same.

1. Select the Source button to select the storage location of the 
application or font file you want to delete.

• Internal Storage - the Internal Compact Flash in the terminal

• External Storage 1 - the External Compact Flash card loaded in 
the card slot of the terminal

• External Storage 2 - for future use

2. Select a file from the list.

3. Select the Delete button. 

4. You will be asked if you want to delete the selected application 
or font file from the storage location. Select Yes or No.

Terminal Settings

File Management

Delete Files
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Delete Log Files

Select this option to delete any data log files, alarm history files and 
alarm status files in the System Default location on the terminal. You 
will be asked to confirm the operation.

Do you want to delete all of the RSView ME Station Log Files? 

Select Yes or No. Any log files not located in the System Default 
location will not be deleted.

Copy Files

From the Copy Files screen, you can select options to:

• Copy Applications - copies an .MER application file from one 
storage location to another.

• Copy Fonts - copies a font file from one storage location to 
another.

Copy Applications or Fonts

The process for copying an application file or a font file is the same.
 

1. Select the Source button to select the location of the application 
or font file you want to copy. 

• Internal Storage - the Internal Compact Flash in the terminal

• External Storage 1 - the External Compact Flash card loaded in 
the card slot of the terminal

• External Storage 2 - for future use

Terminal Settings

File Management

Copy Files

List of files stored 
in Compact Flash 
of terminal.
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2. Select the Destination button on the same screen to open the 
following screen. 

3. Select the Destination button to select the storage location 
where you want to copy the application or font file to. The 
destination cannot be the same as the source location.

• Internal Storage - the Internal Compact Flash in the terminal

• External Storage 1 - the External Compact Flash card loaded in 
the card slot of the terminal 

• External Storage 2 - for future use

4. Select the Copy button to copy the selected application or font 
file to the selected destination. 

If the file exists, you will receive a warning and will be asked if 
you want to overwrite the existing application.

5. Select Yes or No.

TIP RSView looks for .MER files in the 
\RockwellSoftware\RSViewME\Runtime folder 
and font files in the 
\RockwellSoftware\RSViewME\Fonts\ folder.
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Display The Display screen allows you to open screens to access:

• Display Temperature

• Display Intensity

• Screen Saver

• Cursor

Display Temperature

The Display Temperature screen shows the current temperature of the 
display.

The terminals have a CCFL (Cold-Cathode Fluorescent Lamp) 
backlight. This backlight requires temperature control when the 
internal temperature of the product is below 10 °C or above 60 °C. For 
proper backlight operation, the terminal monitors low and high 
temperature conditions. 

• If the internal temperature of the product is below 10 °C, the 
backlight is set to overdrive or the full-rated current setting for at 
least five minutes. 

• If the internal temperature is at or above 60 °C, the backlight is 
set to underdrive; 40% or less of full brightness. This reduces 
heat generation from the backlight.

Temperature monitoring begins when the terminal powers on, or 
when the backlight turns on, for example, exiting screen saver mode. 
The temperature control only affects display intensity; it does not 
restrict the use or operation of the terminal.

When a low or high temperature condition is detected, an error is sent 
to the system event log. If the temperature control is not functioning, 
a noncritical error is sent to the system event log but the terminal 
continues to operate normally.

TIP The CCFL backlight temperature control takes 
precedence over the application Backlight Settings. 

Terminal Settings

Display

Display Temperature
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Display Intensity

The Display Intensity screen lets you view or modify the current 
intensity of the backlight. The default intensity is 100%. When you 
change the intensity, the terminal temporarily changes to that 
intensity. The change is not permanent until you select OK.

The Startup Intensity button toggles between Runtime and Default. If 
Runtime is selected, the terminal startup screens will use the runtime 
intensity setting selected on the above screen. If Default is selected, 
the terminal startup screens will use the terminal default setting, 
which is near 100%.

Screen Saver

The Screen Saver screen lets you:

• disable the screen saver.

• enable the screen saver after the selected idle time.

• adjust the brightness of the screen saver.

• enable/disable the screen saver bitmap.

Terminal Settings

Display

Display Intensity

Terminal Settings

Display

Screen Saver
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Cursor
The Cursor screen enables/disables the on-screen cursor.

Select Up or Down 
Cursor button to 
increase or decrease 
the screen saver 
brightness

Terminal Settings

Display

Cursor
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Font Linking Font linking allows you to run a translated application on the terminal 
by linking a font file to the base font (for example, linking a Chinese 
font file to the base font Arial).

For more details on pre-installed terminal fonts and additional fonts 
available for downloading, see Appendix E.

Terminal Settings

Font Linking

Arial
Courier New
Tahoma
Times New Roman

Show Links
[F1]

Close
[F8]

Courier New
MS Mincho
Tahoma
Times New Roman

Add Fonts
[F1]

Close
[F8] Close

[F8]
Delete Link

[F1]
Edit Link

[F2]

Base font = Arial
Link:
MS Mincho
External storage 1\MSMINCHO.TTC

List of fonts loaded on 
the terminal.

Shows the location and name of the 
font that is linked to the base font 
used by the terminal. If a file is not 
linked, box will be empty.

Deletes linked 
font file (if any)

Edits the link by allowing you to add the 
linked file to a font loaded on the terminal.

Shows all fonts loaded on the terminal except the 
base font. Select the name of the font you are 
linking to the base font. Click the Add Fonts button 
to link the font file for the selected font to the base 
font. You will return to the Linked Fonts screen.

Select Base Font

Linked FontAdd Linked Font
Publication 6182H-UM001D-EN-P - September 2005



Use RSView ME Station        4-27
Input Devices The Input Devices screen lets you access screens to view and modify 
settings for the:

• Keyboard

• Keypad

• Mouse

• Touch Screen

Keyboard and Keypad Setup

From the Keyboard and Keypad screen, you can open the following 
screens to set:

• Key Repeat Settings

• Keypad Settings

Key Repeat Settings for Attached Keyboard and VersaView CE Keypad

The Key Repeat Settings screen configures settings for keys on the 
VersaView CE terminal or keys an attached keyboard.

Field Description Valid Values

Repeat Rate The number of times a key is repeated per 
second when you hold a key down.

Keypad: 0, 2 - 30
Keyboard: Device dependent, 
0, 2-30 is typical

Repeat Delay The amount time that elapses before a key is 
repeated.

200 ms
400 ms 
600 ms
1 sec
1.5 sec
2 sec
2.5 sec

Values are device dependent. 
An unsupported value is 
disabled (grayed).

Terminal Settings

Input Devices

Keyboard or Keypad
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Key Settings for VersaView CE Keypad

The Keypad Settings screen enables/disables Single Key Mode option 
which is used to restrict multiple or simultaneous key presses.

Field Description Valid Values

Single Key Mode Enables or disables Single Key Mode.

If enabled, any programmable key that is 
pressed inhibits all keys until the 
programmable key is pressed again. This 
includes the Alt, Ctrl, Shift keys.

If enabled with abort, any secondary key 
press will terminate the initial key press 
immediately. 

If disabled, there are no restrictions on key 
presses.

Enabled
Enabled with Abort
Disabled (default)

Hold Off Time The length of time to ignore multiple presses 
of the same key.

400 ms

IMPORTANT The keypad cannot produce Home, End, Page Up or 
Page Down when Single Key mode is enabled.
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Touch Screen

The Touch Screen lets you access these screens:

• Calibration

• Cursor

• Double-Tap Sensitivity

Touch Screen Calibration

This screen calibrates the touch screen of the terminal. Touch the 
center of the target (+) each of the four times it appears. When the 
calibration is complete, you will see the message:

"Tap the screen to register saved data. Wait for 30 seconds to 
cancel saved data and keep the current settings."

Cursor

This screen enables or disables the cursor on touch screen terminals. 
Disabling the touch screen cursor will not disable the mouse.
 

IMPORTANT Use a plastic stylus device with a minimum tip radius 
of 1 mm (0.040 in) to prevent damage to the touch 
screen.

Terminal Settings

Input Devices

Touch Screen

Carefully press and briefly hold stylus on the center of the target.
Repeat at as the target moves around the screen.
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Double-Tap Sensitivity

This screen lets you set and test the sensitivity for both speed and 
physical distance between touch screen presses.

• The Set button sets the sensitivity of touch screen presses. 

• The Test button tests the sensitivity of touch screen presses. If 
you double-tap the test button with the time set using the Set 
button, the Test button will reverse its foreground and 
background colors.

Mouse

The Mouse screen sets and tests the sensitivity for both speed and 
physical distance between mouse clicks. This process is identical to 
that for setting Double-Tap sensitivity for the touch screen.

Terminal Settings

Input Devices

Mouse
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Print Setup The Print Setup screen lets you access screens to configure print 
options for: 

• Displays 

• Alarms 

• Diagnostic messages

Display, Alarm, and Diagnostic Print Setup

The setup for printing displays, alarm messages and diagnostics 
messages from an RSView .MER application is the same. The 
Advanced Settings for each function are different.

Advanced Settings for Display Print Setup

Select the Advanced Settings button to:

• change the print orientation (portait or landscape).

• enable or disable draft mode.

Field Description Valid Values

PCL Printer Type of printer to use. Laser (default)
Inkjet

Port Port to use for printing displays, alarm 
messages, and diagnostic messages. 

Network (default)
USB

Network Path Network path of printer to use if the Port 
selection is Network.

519 characters maximum

Advanced Settings Press this button to open additional settings.

Terminal Settings

Networks and Communications

Print Setup
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Advanced Settings for Diagnostic Messages and Alarm Messages

The following screen configures when to print diagnostic or alarm 
messages that are sent to the Network or USB port.

To configure how messages are queued for printing, select the Print 
Messages After button and set one of the following options.

• Specified number of messages

Prints messages after 60 are queued or another specified value. 
The default is 60 (about one full page of messages.)

• 500 messages or timeout period, whichever is first

Prints after 500 messages are queued or a specific time period 
has elapsed, whichever comes first. The default time period is 
168 hours (7 days). You can specify another value. For example, 
if 350 messages are in the queue and 7 days have elapsed, the 
350 messages will print. 

• Specified number of messages or timeout period, 
whichever is first

Prints after a specified number of messages are queued or a 
specific time period has elapsed, whichever comes first. 

The default number of messages to queue is 60. The default 
timeout period is 168 hours (7 days). You can change both 
values. For example, the number of messages is set to 75 and 
the timeout period is set to 48 hours (2 day). If the queue has 75 
messages after only 24 hours, these messages will print. If there 
are only 15 messages in the queue at 48 hours, the 15 messages 
will not print until the time period has elapsed.
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Startup Options The Startup Options screen accesses the following screens to modify:

• RSView ME Station Startup

• Startup Tests

RSView ME Station Startup

The RSView Machine Station Startup screen specifies what action the 
terminal takes on startup:

• Do not start RSView ME Station

• Go to Configure Mode of RSView ME

• Run the Current Application 

This option is available only if an application is loaded.

RSView ME Station will start up based on shortcuts in the Windows 
Startup folder and whether an application is loaded.

Select the On Startup button to switch between Do not start RSView 
ME, Go to Configure Mode, or Run the Current Application. Select the 
button under the last two options to configure specific settings for 
each mode.

Terminal Settings

Startup Options

RSView ME Station Startup
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Configuration Mode

The Configuration Mode Options screen specifies whether the 
terminal will boot up in Configure Mode: 

• with the current application loaded. 

• with the communication configuration of the current application 
or the terminal’s RSLinx communication configuration.

If you select Yes to replace the terminal’s communication 
configuration with that of the application, any changes made to 
the device addresses or driver properties in the RSLinx 
Communications screen will be lost.

These options are available only if an application is loaded in the 
terminal. If an application is not loaded, both options are disabled and 
set to No.

Run Options

The Run Options screen specifies whether to: 

• replace the terminal’s communication (RSLinx) settings with 
application settings when the application is run.

If you select Yes, any changes to the device addresses or driver 
properties in the RSLinx Communications screen will be lost 
when the terminal boots up.

• delete the log files (data, alarm history, alarm status) generated 
by the terminal from the System Default location before running 
the  application. 

Configuration Mode Run Options
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Startup Tests

The terminal can run extended tests on startup. The Startup Tests 
screen provides access to these screens:

• Select Tests

• Startup Tests Settings

Select Tests

The Select Tests screen shows a list of each test that can be performed 
on the terminal at startup and its current On/Off status. You can turn 
any test in the list on or off by selecting the On/Off button. The 
terminal will only run tests with a checked box.

Terminal Settings

Startup Options

Startup Tests
Publication 6182H-UM001D-EN-P - September 2005



4-36        Use RSView ME Station
Startup Tests Settings

From the Startup Tests Settings screen, you can:

• enable extended diagnostics to run on the terminal at startup. 

• disable extended diagnostics at startup.

• specify how many times to repeat the selected tests that are run 
on the terminal during startup. 

The Repeat Count field shows the current value. You can enter a value 
in the range of 0 - 128.
 

IMPORTANT Enabling Extended Diagnostics and setting a high 
Repeat Count will increase the time it takes the 
terminal to reboot.

The tests will run each time you reset or cycle power 
to the terminal until you disable Extended 
Diagnostics. Setting a low repeat count will also 
decrease the startup time.
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System Event Log The System Event Log screen displays a list of system events currently 
logged by the terminal.

• To display System Event Log Details for a specific event, select 
an event and then select the More Details button.

• To clear all System Event Logs, press the Clear All button.

Terminal Settings

System Event Log
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System Information The System Information screen lets you access:

• RSView ME Station information

• Terminal Information

Terminal Information

The Terminal Information screen displays the following details for the 
terminal.

• Total power on time

• Processor temperature

• Battery voltage and battery state

• Amount of memory on terminal

All fields are read only except for memory allocation.

To access details on Memory Allocation, select the Memory Allocation 
button. 

Terminal Settings

System Information

Terminal Information
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Memory Allocation

The Memory Allocation screen displays the:

• amount of allocated storage or program memory. 

• amount of storage or program memory currently in use.

You can modify the allocation of storage or program memory. Press 
the Up or Down button to increase/decrease the memory allocation.  
Each button press changes the allocation by a value of 4. If you 
change the allocation for one type of memory, the other is updated 
accordingly. 

TIP These settings are not retained after a power cycle. 
The settings return to the defaults.
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RSView ME Station Information

The About RSView ME Station screen provides access to:

• RSView ME Station firmware number 

• Rockwell Technical Support information

Terminal Settings

System Information

About RSView ME Station

x.xx.xx.x
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Time/Date/Regional 
Settings

The Time/Date/Regional Settings screen lets you access these screens 
to set:

• Date

• Regional settings

• Time

• Time zone

Date 

The Date screen shows and configures the current date in separate 
Year, Month and Day fields.
 

Field Description Valid Values

Year The current year in a 4-digit format. 1980 - 2099

Month The current month. 1 - 12

Day The current day. The day of the month is 
validated based on the month.

0 - 31

Terminal Settings

Time/Date/Regional Settings

Date
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Time

The Time screen shows and configures the current time in 24-hour 
format in separate Hour, Minute and Second fields.
 

Field Description Valid Values

Hour The current hour in 24-hour format. 0 - 23

Minute The current minute in 24-hour format. 0 - 59

Seconds The current second in 24-hour format. 0 - 59

Terminal Settings

Time/Date/Regional Settings

Time
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Time Zone

The Time Zone screen shows the current time zone that is installed on 
the terminal. Time zones are installed as a part of the operating 
system. Changing the time zone adjusts the current time and date to 
match the new time zone.
 

If the selected time zone supports Daylight Savings, you can select the 
Daylight Savings button.

Daylight Savings

The Daylight Savings screen configures whether daylight savings time 
is in effect for the current time zone. Daylight Savings is set to Yes for 
all time zones except for Japanese, which does support daylight 
savings. Daylight savings changes are not permanently applied until 
you close the Time Zone screen. 

Language Default Time Zone

English (GMT -05:00) Eastern Time (US & Canada)

French (GMT +01:00) Brussels, Copenhagen, Madrid, Paris

German (GMT +01:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna

Japanese (GMT +09:00) Osaka, Sapporo, Tokyo

Terminal Settings

Time/Date/Regional Settings

Time Zone
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Regional Settings

The Regional Settings screen lets you access screens to modify the 
current:

• Language

• Numeric Format

• Long Date Format

• Short Date Format

• Time Format

The current language is shown at the bottom of the Regional Settings 
screen.

Language

The Language screen allows you to select a language that is installed 
on the terminal. Languages are installed as a part of the operating 
system.

Numeric Format screen

The Numeric Format Screen allows you to modify the decimal 
separator used by the current language. The default decimal separator 
is ".". The field will accept a separator up to 3 characters. 

Terminal Settings

Time/Date/Regional Settings

Regional Settings

Terminal Settings

Time/Date/Regional Settings

Regional Settings

Language

Terminal Settings

Time/Date/Regional Settings

Regional Settings

Numeric Format
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Time Format

The Time Format screen configures the time format for the current 
language. A sample of the current time is shown using the currently 
selected format. 

Field Description Example

Time Format

h:mm:ss tt (default)
h = hour, no leading zero
tt = AM or PM symbol

7:23:02 AM or 1:13:31 PM
11:43:59 AM

hh:mm:ss tt
hh = hour with leading zero
tt = AM or PM symbol

07:23:02 AM or 01:13:31 PM
11:43:59 PM

H:mm:ss
H = hour in 24 hour format, no leading zero

7:03:42 or 1:13:32
23:43:59

HH:mm:ss
HH = hour in 24-hour format with leading zero

07:03:42 or 01:13:22
23:43:59

AM Symbol Characters to indicate AM. If the time format is 
set to h:mm:ss tt or hh:mm:ss tt, you can modify 
the AM symbol. 

AM (default)
12 character maximum

PM Symbol Characters to indicate PM. If the time format is 
set to h:mm:ss tt or hh:mm:ss tt, you can modify 
the PM symbol. 

PM (default)
12 character maximum

Separator Character(s) that separate fields in time format. : (default)
3 character maximum

Terminal Settings

Time/Date/Regional Settings

Regional Settings

Time Format
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Short Date Format

The Short Date Format screen configures the short date format used 
by the current language. A sample of the current date is shown using 
the currently selected short date format. 

Field Short Date Formats Example

Format M/d/yyyy (default)
M/d/yy
MM/dd/yy
MM/dd/yyyy
yy/MM/dd
yyyy-MM-dd
dd-MMM-yy

1/2/2003
1/2/03
01/02/03
01/02/2003
03/01/02
2003-01-02
02-Jan-03

Separator Character(s) separator for fields in time format. 
The default separator is either - or / depending 
on short date format.

-  or / (default)
3 character maximum

Terminal Settings

Time/Date/Regional Settings

Regional Settings

Short Date Format
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Long Date Format

The Long Date Format screen configures the long date format used by 
the current language. A sample of the current date is shown using the 
currently selected long date format. 

Field Short Date Formats Example

Format

dddd, MMMM, dd, yyyy (default)
dddd is name of week day
MMMM is name of month
dd is 2-digit day of month with leading zero
yyyy is 4-digit year

Monday, January 01, 2003

MMMM dd, yyyy
MMMM is name of month
dd is 2-digit day of month with leading zero
yyyy is 4-digit year

January 01, 2003

dddd, dd MMMM, yyyy
dddd is name of week day
dd is 2-digit day of month with leading zero
MMMM is name of month
yyyy is 4-digit year

Monday, 01 January, 2003

dd MMMM, yyyy
dd is 2-digit day of month with leading zero
MMMM is name of month
yyyy is 4-digit year

01 January, 2003

Terminal Settings

Time/Date/Regional Settings

Regional Settings

Long Date Format
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Chapter 5

Windows CE .NET Operating System

Chapter Objectives This chapter provides information on:

• Windows CE .NET architecture

• Windows CE .NET programs for the VersaView CE

• Using Windows CE .NET

• VersaView CE terminal memory

• Control Panel Applications for configuring the VersaView CE 
terminal

Windows CE .NET 
Architecture

The Windows CE .NET operating system from Microsoft provides a 
portable, scalable, real-time operating system for embedded devices. 
The modular design of Windows CE .NET allows the platform builder 
to include only those features required for the specific product 
application. However, Windows CE .NET is still a subset of the other 
Microsoft operating systems, and it runs Win32 applications.

Windows CE .NET Benefits

There are three major differences between Windows CE .NET and  
other Microsoft Windows operating systems. Windows CE .NET:

• has a small memory footprint requirement

• runs on a wide variety of processor architectures

• has a real-time scheduler 

The small memory footprint allows Windows CE .NET to operate in 
small solid-state memory devices (8 MB typical). In contrast, PC-based 
Windows require hundreds of megabytes of storage space. 

VersaView CE terminal has an x86 based processor to maximize the 
consistency between Windows 2000/XP and Windows CE .NET 
applications.
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Compiling Windows CE .NET Applications

While the Windows CE .NET operating system brings a higher level of 
standardization to embedded computing devices, third-party software 
applications must still be compiled and tested to run on each 
Windows CE .NET device. The compilation is required to tailor the 
software application to the device’s processor and unique hardware 
features. 

Microsoft created hardware reference models for the Handheld (HPC) 
and the Pocket (PPC) PC so that third-party applications can run on 
these standard platforms. There are no hardware standards for 
embedded devices. 

The VersaView CE terminal is largely compatible with HPC and PPC, 
so applications that are compiled for the x86 may run on the 
VersaView CE terminal.

Windows CE .NET 
Programs for the 
VersaView CE

The VersaView CE terminal includes RSView Machine Edition 
software. Refer to the user manual and online help shipped with 
RSView Studio for information about using this software.

The Windows CE .NET operating system and applications are stored 
on the Internal Compact Flash of the VersaView CE for permanent 
storage and can be accessed as the \Storage Card directory in 
Windows Explorer. (They are also available on the VersaView CE 
Accessory CD). The operating system and RSView Machine Edition are 
loaded into RAM on startup to improve response time. 

Additional programs can be installed using ActiveSync or an External 
Compact Flash card on the VersaView CE terminal.

The VersaView CE ships with the following programs pre-loaded.

Application Description

Microsoft Internet Explorer 5.5 Web browser

ActiveSync Support Connects the VersaView CE to a desktop computer 
running ActiveSync.

Control Panel Set of configuration tools for setting up the 
VersaView CE terminal

Windows Explorer (Shell) User interface to the system much like a desktop PC

Remote Desktop Connection Services for thin client applications included on the 
Accessory CD (formerly Terminal Server Client)

WordPad Text editor

PDF Viewer Reader for Adobe Acrobat PDF files
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Other Windows CE .NET programs are available. Most of these 
programs have been written for PPC devices, and some may run on 
the VersaView CE. For more information on Windows CE .NET 
programs, see the Knowledgebase at 
http://support.automation.rockwell.com.

Installing Applications

The VersaView CE terminal allows field-installation of third-party 
software. Refer to Chapter 8 for details on how to use Microsoft 
ActiveSync to install and remove application programs on the 
VersaView CE. Each application program must be compiled for the 
x86 processor.  

If the application program literature does not specifically identify the 
VersaView CE as a compatible hardware platform, take caution if 
trying to install and run it on the terminal. While the program may 
operate on the X86 processor, there could be conflicts with running it 
on the VersaView CE terminal. Testing is essential.

Using Windows CE .NET The Windows CE .NET operating system provides a user interface 
similar to other Microsoft Windows operating systems. This user 
interface has been simplified to reduce the memory footprint. 
Therefore, minor differences exist between the desktop Windows 
interface and the Windows CE .NET interface.

The Windows CE .NET graphical interface simplifies interaction with 
the computer. You simply select and move objects on the screen by 
tapping and dragging them using your finger or stylus on the touch 
screen, or using an external mouse.  

The VersaView CE terminal has a keypad, touch screen, or input panel 
for operator input. In addition, an external keyboard or mouse can be 
connected to one of the USB ports of the terminal. 

TIP If you have difficulty selecting objects using the 
touch screen, run the calibration program described 
on page 5-14.
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You may find it convenient to use the following shortcuts. These 
shortcuts work with the VersaView CE terminal keypad, an attached 
keyboard, or the input panel.

Shortcut Description

Ctrl+Esc Opens the Windows CE .NET Start menu. Use arrow 
keys to select a program and Enter to run it. 

Alt+Tab Starts the Task Manager.

Enter This key is equivalent to double-tap. In a dialog box, 
you can select Enter or OK.

Selects the previous control in a dialog.

Selects the next control in a dialog.

Ctrl+Tab Opens the next tab in a tabbed dialog.

Esc Closes a dialog without saving changes.

Arrow keys Selects controls or items from a list in a dialog.

Alt Activates menus.

Shift + Tab or

Tab or
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Start Menu and Taskbar

Use the Start menu to run programs, configure settings, and open 
recently-used documents. A single-click on the Start menu button on 
the bottom left of the screen brings up the menu. Subsequent clicks 
select the program or item you want to open. The key sequence 
Ctrl+Esc also activates the Start menu.

The taskbar across the bottom of the screen contains buttons for 
programs already running, along with a status area and a Desktop 
icon. You can alternately minimize and maximize an open application 
by clicking on its taskbar button. Double-clicking on any icon in the 
status area shows more information about that function. A single-click 
on the Show Desktop button (far right side of taskbar) minimizes all 
open windows and displays the VersaView CE computer desktop. You 
can close an application by clicking with the right mouse button on its 
taskbar button and choosing Close.

Command Bar

A Windows CE.NET program has a command bar located across its 
top. This command bar contains pull-down menu names and toolbar 
buttons for the application.

Click on a menu name or toolbar icon to interact with the specific 
program. The Help (?) button on the right side of the command bar 
provides application-specific help. The Exit (X) button on the far right 
side of the command bar exits the application. 

Windows CE .NET command bar does not have a Minimize button. 
Click the taskbar button to minimize a program window, or use the 
Show Desktop button to minimize all open program windows.
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Finding Files

Select Start>Programs>Windows Explorer to locate files on the 
VersaView CE terminal. You can alternately double-click the My 
Computer icon on the Desktop to open the Windows Explorer 
program. Windows Explorer allows you to browse and manipulate the 
VersaView CE files and folders. The Edit menu allows you to move 
files from one location to another using the Copy or Cut and Paste 
commands. When you create and save a new file, it is stored in the 
My Documents folder unless you specify another location. 

Browsing Web Pages

Select Start>Programs>Internet Explorer to view Web pages. You can 
alternately double-click the Internet Explorer icon on the Desktop to 
open the Internet Explorer program. To access pages stored on the 
VersaView CE, use the File>Open command and select the Browse 
button to locate the file. To view Internet or Intranet pages, type a 
URL in the Address box.  

Before you can access remote Web pages, the VersaView CE must be 
connected to a network. See page 5-12 for details on configuring the 
Ethernet interface. Additional network settings such as a Proxy Server 
can be configured in the Internet Explorer application using the 
Options command under the View menu.

The Microsoft Internet Explorer application is similar to the PC 
version. It offers many of the same features of the PC version, and can 
be used to view most Internet HTML web pages. Some advanced web 
features may not be fully supported.

Printing

Some VersaView CE software applications may support printing. To 
print from these applications, select the File>Print command. A PCL 
compatible printer must be connected to the USB or Ethernet port on 
the VersaView CE terminal.

TIP The VersaView CE file system resides in RAM and 
flash memory. RAM is volatile and is not persistent 
after a power cycle. Save files that must be persistent 
to the\Storage Card Folder that resides on the 
internal Compact Flash Card.
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VersaView CE Memory The VersaView CE has the following memory areas.

• Boot ROM

• Internal Compact Flash

• Dynamic RAM

• External Compact Flash Cards

• USB Mass Storage Devices

Boot ROM

The boot ROM is used to power-up the VersaView CE, perform 
power-up self tests, and load the Windows CE .NET operating system 
into dynamic RAM. The boot ROM code is not user accessible.

Internal Compact Flash

The Internal Compact Flash is the main storage memory in the 
VersaView CE terminal. The Windows CE .NET operating system and 
user applications are stored in flash memory. On powerup, the 
operating system and any auto-start applications are transferred to 
dynamic RAM, where they are executed.  

The remainder of the flash memory is a FAT partition that appears as a 
folder named "\Storage Card" in Windows CE .NET. Files stored here 
are persistent (saved even after a reset or power cycle).

WARNING Only programs and files loaded in the \Storage Card 
folder are permanently saved to flash memory. All 
other folders or files existing in RAM are lost when 
power is cycled.
Publication 6182H-UM001D-EN-P - September 2005



5-8        Windows CE .NET Operating System
Dynamic RAM

The RAM memory is split into two segments: Storage and Program 
memory. The System application in the Control Panel has a slider 
control that determines the allocation mix between Storage and 
Program memory. 

The Storage memory segment is a virtual RAM disk known as the 
Object Store. It provides specialized storage for the Windows CE .NET 
Registry, the file system, and system databases. The RAM-based 
Storage memory segment is not persistent as in HPC devices, so all 
files stored here must be re-created at every startup.

The Program memory segment provides traditional computer 
RAM-like functions for holding application code, heaps, stacks, and 
data at runtime. The VersaView CE loads the Windows CE .NET 
operating system and any auto-start applications from flash memory 
into the Program memory at powerup.

External Compact Flash Cards

External Compact Flash cards are available for the VersaView CE 
terminal to increase the space for storing files. When a Compact Flash 
Card is installed in the card slot of the VersaView CE, a StorageCard2 
icon is displayed under My Computer, and files on the memory card 
can be manipulated using the Windows Explorer program. 

The card slot on the VersaView CE supports Type 1 Compact Flash 
cards. The cards (2711P-RCx) are available in different sizes. For 
details on how to install/remove cards from the card slot, refer to 
Chapter 6. 

USB Mass Storage Devices

USB devices that comply with the "USB Mass Storage Class 
Specification, Version 1.0" are supported to enable a wide variety of 
USB-based storage devices such as hard drives, floppy disks, CD-ROM 
drives and ATA flash readers. Up to 10 devices are supported, 
concurrently. DVD drives are not supported.
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Control Panel Applications The VersaView CE terminal has user-configurable settings which are 
accessed from the Windows CE .NET Control Panel applications. 
These applications are similar to other Microsoft Windows operating 
systems. Select Start>Settings>Control Panel to open the Control Panel 
window.

Control Panel Applications on the VersaView CE

Application Description See page

Certificates Manages digital certificates used by some applications 
for establishing trust and secure communications. 

5-27

Date/Time Sets the date and time on the terminal. 5-25

Dialing Configures dialing rules for telephone and modem 
communications.

5-11

Display Configures the display and color settings, the brightness 
of the backlight, and the screen saver.

5-18

Extended Diagnostics Enables tests to run on the terminal at each startup and 
the number of times to run each test.

5-20

Hardware Monitor Views the current voltage and temperature, and system 
events logged on the terminal.

5-22

Input Panel Configures an input panel for entering/editing data on a 
touch screen terminal.

5-17

Internet Options Configures Start and Search pages, clears Cache and 
History, and specifies connection and security settings for 
Internet Explorer.

5-27

Keyboard Configures settings for an attached keyboard. 5-15

Keypad Configures settings for keys on the VersaView CE 
terminal.

5-16

Mouse Sets the sensitivity of the mouse, if attached. 5-17

Network and Dial-up 
Connection

Configures ActiveSync and Ethernet network connections 
between your terminal and a computer.

5-12

Owner Configures network and user identification information 
for your terminal. 

5-10

Password Sets a password to protect your terminal against 
unauthorized use. The password can be enabled at 
system startup or when the screen saver is activated.

5-11

PC Connection Selects a configured connection for connecting your 
VersaView CE terminal to another computer. 

5-13
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Owner

The Owner dialog provides network and user identification 
information for your VersaView CE terminal. 

Network ID

The Network ID tab identifies the VersaView CE terminal to a network 
so it can gain access to network resources. A username, password, 
and domain may be necessary; if so, contact your system 
administrator. When done, click OK. 

Power Provides information on the battery condition of the 
terminal and other power management features.

5-22

Regional Settings Sets the clock, date and language, and configures formats 
for numbers, currency, time, date and regional settings.

5-25

Remove Programs Removes programs installed on your terminal. 5-28

Storage Manager Displays information on terminal’s hard drive, Also 
reformats and manages partitions for hard drive.

5-28

System Lists system properties like memory allocation, device 
information, operating system version.

5-23

Touch Calibrates the touch screen, sets the sensitivity of touch 
screen taps, and enables/disables the touch screen 
cursor.

5-14

Application Description See page
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Identification and Notes 

The Identification tab defines optional user information for your 
VersaView CE terminal. Use the Notes tab if it is necessary to 
document additional information.

Password
The Password dialog lets you define a password to protect your 
terminal against unauthorized use. You can require that the defined 
password be entered each time the terminal is restarted and/or when 
the screen saver is activated. Select OK to activate settings.

Dialing
The Dialing dialog is a standard Windows control panel application 
that configures dialing rules for modem communications on your 
VersaView CE terminal.
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Network and Dial-up Connections

The Network and Dial-up Connections application lets you configure:

• ActiveSync connection between your VersaView CE terminal and 
another computer.

• Ethernet network connection

ActiveSync Connection

For details on establishing an ActiveSync connection between your 
VersaView CE and a computer, see chapter 8. 

Serial Connect is the default, pre-configured ActiveSync connection.

Configuring Ethernet Connection 

To configure an Ethernet network connection:

1. Select the Network and Dial-up Connections application.

2. Select the PCI-E100CE1 icon to configure Ethernet settings. 

3. On the IP address tab, select Obtain an IP address via DHCP or 
Specify an IP Address

• IP addresses may be automatically assigned if DHCP is 
enabled for the Ethernet adapter. 

• If you select Specify an IP Address, complete the three text 
boxes with information from your network administrator.

Subnet Mask must be 
identical to the server 
subnet mask.

IP Address must be 
unique on the LAN.

Default Gateway
is optional.
Publication 6182H-UM001D-EN-P - September 2005



Windows CE .NET Operating System        5-13
4. Select OK in the title bar. A window will prompt you to either 
remove and reinstall your card or restart the device for the new 
settings to take effect. Select OK in the notification window.

For the Built-in Ethernet Controller, you must restart the 
terminal.

5. Select OK to close the Network Configuration dialog.

PC Connection

The PC Connection dialog lets you select and enable a configured 
connection between your VersaView CE terminal and another 
computer. The current connection is listed at the bottom of the tab. To 
change the connection to another computer, press the Change button. 
A dialog will open allowing you to select another configured 
computer.Click OK when done to activate change.

TIP If DHCP is enabled for the adapter, Name Server 
addresses may be automatically assigned. You can 
specify additional WINS or DNS addresses on the 
Name Servers tab.

WARNING Adjusting the PC connection named "Serial_Connect" 
may result in an inability to connect with your 
desktop computer via ActiveSync.
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Touch

The Touch Properties dialog lets you perform the following 
operations for VersaView CE touch screen terminals:

• set double-tap sensitivity

• calibrate the touch screen

When done performing operations, remember to select OK in the title 
bar to activate settings.

Double-Tap Sensitivity
The Double-Tap tab sets the sensitivity for both the speed and 
physical distance between screen taps. Double-tap the top grid to set 
the sensitivity. Double-tap the bottom grid to test the setting.

Calibration
The Calibration tab provides instructions on how to calibrate the 
touch screen. You may have to do this if the terminal is not 
responding to your taps. Select the Recalibrate button. Touch the 
center of the target as it moves around the screen. When the target 
returns to its initial position, the calibration is complete.
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Keyboard

The Keyboard dialog configures key settings for a keyboard that is 
attached to the USB port of the VersaView CE terminal. You can adjust 
the: 

• rate for repeating a key press

• delay from the first key press to when repeating begins

To adjust key repeat settings, select the Enable character repeat check 
box. Adjust how often a key repeats by moving the slider between 
Slow and Fast. To adjust the delay between key repeats, move the 
slider between Long and Short. Tap the field at the bottom of the 
dialog and then hold down a key to test the new settings.

When done performing operations, remember to select OK in the title 
bar to activate settings.
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Keypad

Use the Keypad dialog to:

• configure key settings for keys on the VersaView CE terminal.

• adjust the rate for repeating a key press and the delay from the 
first key press to when repeating begins

• enable/disable multi-key lockout.

When done performing operations, remember to select OK in the title 
bar to activate settings.

Key Repeat

To adjust repeat settings for keys on an attached keyboard, select the 
Enable character repeat check box. Then adjust how often a key 
repeats by moving the slider between Slow and Fast. To adjust the 
delay between key repeats, move the slider between Long and Short. 
Tap the field at the bottom of the dialog and then hold down a key to 
test the new settings.

Multi-Key/Hold-Off Lockout

The Multi-Key/Hold-Off tab restricts multiple or simultaneous key 
presses on the VersaView CE terminal and specifies a hold-off delay 
between presses of the same key.
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Multi-Key Lockout
Under Multi-Key Lockout, select one of the following options:

• Enabled - any programmable key that is pressed inhibits all keys 
until the programmable key is pressed again. This includes the 
Alt, Ctrl, and Shift keys. 

• Enabled with Abort - any secondary key press will terminate the 
initial key press immediately.

• Disable - places no restrictions on key presses. Clear both check 
boxes. 

Hold-Off Delay
If enabled, this option will ignore multiple presses of the same key for 
a specified length of time. To enable this option, select the Enable 
Hold-Off mode check box. Then adjust the delay time by moving the 
slider to the left or right to increase or decrease the hold off time.

Mouse
If a mouse is attached to one of the USB ports of the VersaView CE 
terminal, you can set the sensitivity for both the speed and physical 
distance between mouse taps. Double-tap the top grid to set the 
sensitivity. Double-tap the bottom grid to test the setting. Click OK

Input Panel
The Input Panel dialog sets properties for the soft Keyboard input 
panel. Use the Options button to select Large or Small keys, and other 
soft key options. Click OK after making any changes.

IMPORTANT The keypad cannot produce Home, End, Page Up or 
Page Down when Multi-Key Lockout is enabled.
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Display

The Display dialog set the following display properties for the 
VersaView CE terminal:  

• background

• appearance

• backlight

• screen saver

• cursor

When done performing operations, remember to select OK in the title 
bar to activate settings.

Background

The Background tab lets you select an image to use for the VersaView 
CE desktop and whether the image should be tiled.

Appearance

The Appearance tab let you change the color scheme of your desktop.
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Backlight

The Backlight tab adjusts the brightness of the terminal’s backlight. To 
adjust the brightness of the terminal’s backlight, move the slider to the 
left or right. To use the adjusted brightness when the terminal starts 
up, select the Use Brightness at startup check box.

Screen Saver

The Screen Saver tab enables and disables the screen saver. To enable 
the screen saver, select the check box and then select an idle time. 
This will activate the screen saver after the terminal has been idle for 
the specified time. You can also select a screen saver image. To adjust 
the brightness of the screen saver, move the slider to the left or right.

To add a custom image for the screen saver, copy the bitmap (.bmp 
file) to the \Storage Card folder and then use the Browse button to 
select the image. You can disable the screen saver bitmap by selecting 
(None) from the Image drop-down list. 

Cursor

Use the Cursor tab to enable or disable the visible screen cursor.
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Extended Diagnostics

From the Extended Diagnostics dialog, you can:

• enable/disable extended diagnostics to run on the VersaView CE 
terminal at each reset or power cycle.

• select specific tests to run.

• specify the number of times to repeat each test.

When done performing operations, remember to select OK in the title 
bar to activate settings.

Iteration Count

From the Iteration tab, select the Enable Extended Diagnostic box to 
run selected tests on the VersaView CE terminal at each reset or 
startup. You can also specify how many times to run each test. The 
tests are selected from the Tests and More Tests tab.

The selected tests will run each time the VersaView CE terminal is 
reset until disabled (by clearing the Enable Extended Diagnostics 
check box).

TIP Enabling Extended Diagnostics and setting a high 
Interaction count will increase the time it takes for 
the terminal to start up.

The tests will run each time you reset or cycle power 
to the terminal until you disable Extended 
Diagnostics. Setting a low iteration count will also 
decrease the start up time.
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Tests

The Tests and More Tests tabs show a list of tests that can be 
performed on the VersaView CE terminal at startup and the on/off 
status of each test. The terminal will run only the test with checked 
boxes. To enable a test, select the check box; to disable a test, clear 
the check box. Press the Clear All button if you want to clear all check 
boxes.
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Hardware Monitor

Use the Hardware Monitor dialog to:

• view the current battery voltage state and temperature of the 
display and processor.

• view and/or clear all recorded events.

When done performing operations, remember to select OK in the title 
bar to activate settings.

Voltages and Temperature
The Voltages and Temp tab shows both the nominal and actual  
voltage of the battery in the VersaView CE terminal and its current 
status. The current temperature of the display and the processor is 
also shown along with its status.

Event Log
The Event Log shows a list of all events that have occurred in the 
system. Select the Clear Events button to clear all events from the list.

Power
The Battery tab on the Power dialog shows the status of the internal 
battery in the terminal. Replace the battery in the terminal, when the 
Battery State is Low or Very Low. For the VersaView CE terminal, you 
can ignore the other tabs.
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System 

The System dialog provides system, device and copyright information 
for the VersaView CE. It also provides memory allocations for storage 
and programs. If you make memory adjustments, remember to click 
OK to activate settings. 

General

The General tab displays system operating and computer information.

Memory

The Memory tab displays the amount of memory allocated and in use 
for storage and programs. These settings are controlled by the system 
at startup and can be adjusted by an application program. Normally, it 
is not necessary to the change the setting unless a program reports a 
need for more memory. Move the slider to the left to increase the 
allocation for program memory. The memory allocations are 
automatically adjusted as you move the slider.
Publication 6182H-UM001D-EN-P - September 2005



5-24        Windows CE .NET Operating System
Device Name

The Device Name tab defines a name and description for your 
VersaView CE terminal. This information identifies your CE terminal to 
other computers on the Ethernet network. The name must be unique 
on the network. You must change the name from the initial default the 
terminal was shipped if more than one VersaView CE terminal is 
present on your Ethernet network.

.The device name must include:

• 1 to 15 characters

• a leading alpha character in the range a - z or A - Z

• remaining characters in the range a - z, A - Z, 0 - 9 or - (hyphen)

The device description is optional but useful if you want to further 
describe a specific terminal.  

Copyrights

The Copyright tab provides copyright information for your VersaView 
CE terminal.
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Date/Time

The Date/Time dialog sets the current date and time for the selected 
time zone. Changing the time zone will adjust the date and time 
accordingly. Select the check box if Daylight Savings is in effect for 
the current time zone. 

The time appears according to the format set in the Regional Settings 
dialog. After making adjustments, select the Apply button and then the 
OK button.

Regional Settings

Use the tabs on the Regional Settings dialog to select a language and 
then set the format for how the time, date, and numbers appear for 
the selected language. 

When done performing operations, remember to select OK in the title 
bar to activate settings.

Language

The Language tab selects a language that is installed on the VersaView 
CE terminal. Languages are installed as a part of the operating system.
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Time

The Time tab configures the time format for the selected language. A 
sample of the current time format is shown. This sample changes as 
you make adjustments. You can adjust the time format, the separator 
between the time fields, and the AM/PM symbol.

Date

The Date tab configures the style of the short date format and the long 
date format for the selected language. A sample of the current formats 
is shown. These samples are updated as you make changes.

Number

The Number tab configures how negative and positive numbers will 
appear for the selected language. The appearance of the current 
formats is shown for both positive and negative numbers. These 
samples are updated as you make changes.
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Internet Options

The Internet Setting dialog provides tabs to configure parameters for 
accessing and using  the Internet on your VersaView CE device. 

Certificates

The Certificates dialog manages digital certificates used by some 
applications for establishing trust and secure communications. 
Certificates are signed and issued by certificate authorities and are 
valid for a prescribed period of time. 
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Remove Programs

Use the Remove Programs dialog to remove installed programs from 
your terminal. The dialog which shows a list of programs that can be 
removed. Select a program from the list and then select the Remove 
button. Click OK.

Storage Manager

Use the Storage Properties dialog to display information about the 
Internal Compact Flash Card and other storage devices such as the 
External Compact Flash Card and USB Mass Storage Devices. From 
this dialog, you can also configure partitions and reformat the device.

WARNING Do not try to alter the Internal Compact Flash storage 
device that is displayed under Storage Info as DSK1: 
IDE Hard Disk Drive. You may not be able to reboot 
the terminal if you modifying the Internal Compact 
Flash partitions.
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Chapter 6

Install and Replace Components

Chapter Objectives This chapter shows how to install, replace or upgrade various 
components of the terminal.

• Logic module

• Communication module

• Display module

• RAM and internal compact flash

• Battery

• Display module bezel

• Backlight

• AC power supply

• Product label

• Keypad legend inserts

• External compact flash card

Required Tools
• #00, #1, and #2 Phillips screwdriver

• Electrostatic Discharge (ESD) wristband

Precautions Before installing or replacing any components, disconnect power 
from the terminal. During installation, take care not to touch any of 
the exposed electronic components.

WARNING Disconnect all power from the terminal before 
installing or replacing any components. Failure to 
disconnect power may result in electrical shock 
and/or damage to the terminal.

ATTENTION Be careful when touching any of the exposed 
electronic components to prevent damage from 
Electrostatic Discharge (ESD).

Work in a static free environment and wear a 
properly grounded ESD wristband.
1 Publication 6182H-UM001D-EN-P - September 2005



6-2        Install and Replace Components
Compatibility of 
Components

When assembling components of a terminal or replacing the internal 
compact flash in a logic module, the components must be compatible.

To verify compatibility of the internal compact flash with the logic 
module of the terminals, you must know what version of RSView ME 
and the operating system is running on the terminal. 

1. Locate the green label on the logic module to determine the 
revision level of your terminal.

• Rev B: Contains RSView ME 3.0 and Windows CE 3.0 

• Rev C: Contains RSView ME 3.10 and Windows CE 4.1 

• Rev D: Contains RSView ME 3.20 and Windows CE 4.1

• Rev E: Contains RSView ME 4.0 and Windows CE 4.1

2. Determine the series of the internal compact flash and logic 
module from the label.

VersaView CE Terminal Compatibility
The table matches the series of the internal compact flash cards with 
the correct series of the logic module for the terminals. The logic 
module is available with or without memory installed. 
 

RSView ME terminals are compatible with .mer applications that are 
the same version or a previous version. For example, RSView ME 3.20 
terminals can run RSView 3.0, 3.10, and 3.20 .mer applications.

When upgrading from RSView ME 3.0 to 3.1 or later, the appropriate 
changes are made to the OS from Windows CE 3.0 to  
Windows CE 4.1.

Terminal 
Revision

Logic Module 6189-RPxH (with 
memory) is compatible with:

Internal Compact Flash
6189-RW1, 2, 3, 4

RSView ME Version OS Version

Rev B(1) Series A: 6189-RPxH/A Series B: 6189-RWx/B RSView ME 3.0 Windows CE 3.0

Rev C Series B: 6189-RPxH/B Series C: 6189-RWx/C RSView ME 3.10 Windows CE 4.1

Series D: 6189-RWx/D 
Series E: 6189-RWx/E

RSView ME 3.20 Windows CE 4.1

Series F: 6189-RWx/F RSView ME 4.0 Windows CE 4.1

Rev D Series C: 6189-RPxH/C 
Series D: 6189-RPxH/D

Series D: 6189-RWx/D 
Series E: 6189-RWx/E

RSView ME 3.20 Windows CE 4.1

Series F: 6189-RWx/F RSView ME 4.0 Windows CE 4.1

Rev E Series D: 6189-RPxH/D 
Series E: 6189-RPxH/E

Series D: 6189-RWx/D (2) 
Series E: 6189-RPxH/E (2)

RSView ME 3.20 Windows CE 4.1

Series F: 6189-RWx/F RSView ME 4.0 Windows CE 4.1

(1) When upgrading RSView ME 3.0 to 3.10 or higher, the Firmware Upgrade Kit is required. 

(2) Recommend firmware upgrade to align the firmware in the logic module and the internal compact flash.
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Install or Replace the Logic 
Module

This section shows how to install and replace the logic module. If the 
display module and logic module are ordered as separate 
components, attach the logic module to the display module before 
panel installation.

The logic module is available with or without RAM and internal 
compact flash installed. If ordered as separate components, you must 
install the memory before attaching the logic module to the display 
module. 

To install a logic module:

1. Disconnect power from the terminal.

2. If the terminal is removed from panel, set the terminal, display 
side down, on a clean, flat, stable surface to prevent scratches.

3. Position the logic module over the back of the display module 
until the two connectors on the bottom of the logic module align 
with the connectors on the display module. 

4. Push down on the logic module until firmly seated.

5. Tighten the six captive screws that secure the logic module to 
the display module to a torque of 0.68 Nm (6 to 8 in-lb).

TIP If replacing the logic module, you may want to 
remove the RAM and compact flash to reuse in new 
logic module.

Captive
Screw

Logic Module

Captive screws 
on top and bottom
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To replace the logic module:

Before replacing the logic module, you must remove the 
communication module, if attached. You will also need to remove the 
Internal RAM and compact flash from the logic module to reuse in the 
new logic module.

1. Disconnect power from the terminal.

2. Disconnect all power and communication cables.

3. If the terminal is removed from panel, set the terminal, display 
side down, on a clean, flat, stable surface to prevent scratches.

4. Remove the four screws that attach the communication module 
(if attached) to the logic module. Carefully lift the 
communication module away from the logic module.

5. Loosen the six captive screws that secure the logic module to 
the display module.

6. Carefully lift the logic module away from the back of the display 
module.

7. If reusing the memory in the new logic module:

• Remove the RAM and internal compact flash from the logic 
module.

• Insert the RAM and internal compact flash in the new logic 
module.

8. Install the new logic module.

9. Attach the communication module, if necessary.

Logic Module

Communication Module

Display Module

Captive Screw

Screw

ATTENTION Wear a properly grounded ESD wristband 
before touching any of the electronic 
components in the logic module.
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Install or Replace a 
Communication Module

This section shows how to install and replace a communication 
module. The communication module installs over the logic module. 
The communication modules are available as separate catalog 
numbers for specific communication protocols. The installation is the 
same for all modules regardless of the communication type. 

To install a communication module:

1. Disconnect power from the terminal.

2. If the terminal is removed from panel, set the terminal, display 
side down, on a clean, flat, stable surface to prevent scratches.

3. Remove the label covering the communication module 
connector on the logic module.

4. Position the communication module over the logic module so 
that the connectors on bottom of module align with connectors 
on the logic module.

TIP The logic module must be attached to the display 
module before you attach the communication 
module.

Logic Module

REMOVE LABEL TO INSTALL
COMMUNICATION MODULE
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To prevent ESD between the modules, allow the communication 
module to touch the logic module before making connection.

5. Push down on the communication module until the connectors 
are firmly seated.

6. Tighten the four screws that secure the communication module 
to the logic module to a torque of 0.68 Nm (6 to 8 in-lb).

To replace a communication module:

1. Disconnect power from the terminal.

2. Disconnect the communication cables from the module.

3. Remove the four screws that secure the communication module 
to the logic module.

4. Carefully lift the communication module away from the logic 
module and set aside.

5. Install the new communication module.

Communication Module

Connector

Logic Module

Screw

Attached
Communication Module

WARNING Do not connect or disconnect any communication 
cable with power applied to this device or any 
device on the network. An electrical arc could cause 
an explosion in hazardous location installations. Be 
sure that power is removed or the area is 
nonhazardous before proceeding.
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Replace the Display 
Module

This sections shows how to replace the display module. It is necessary 
to remove the communication module from the logic module to 
perform this operation.

1. Disconnect power from the terminal.

2. Remove the terminal from the panel.

3. Detach the communication module (if attached) from the logic 
module by removing the four screws.

4. Loosen the six captive screws that attach the logic module to the 
display module.

5. Carefully lift the logic module from the terminal.

6. Set the display module aside.

Communication Module

Display 
Module

Logic Module

Logic Module

Captive screws 
on top and bottom
Publication 6182H-UM001D-EN-P - September 2005



6-8        Install and Replace Components
7. Position the new logic module over the new display module so 
that the connectors align.

8. Push down on the logic module until firmly seated.

9. Tighten the six captive screws that secure the logic module to 
the display module to a torque of 0.68 Nm (6 to 8 in-lb). 

10. Attach the communication module (if necessary) and tighten the 
four screws to a torque of 0.68 Nm (6 to 8 in-lb).
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Upgrade RAM and Internal 
Compact Flash

The logic module is available with or without RAM/internal compact 
flash installed. If RAM and internal compact flash are ordered as 
separate components, you must install the memory before attaching 
the logic module to the display module. The internal compact flash 
card contains flash memory, the operating system and Machine 
Edition software which is required to boot and run the terminal.  

To replace RAM and/or internal compact flash:

1. Remove power from the terminal.

2. Place the terminal, display side down, on a flat stable surface.

3. Loosen the six captive screws that secure the logic module.

4. Carefully lift the logic module away from the terminal and turn 
over to expose the circuit board.

5. Locate the RAM module on the circuit board. Pull the metal 
retaining clips away from the module and slide out the RAM 
module.

6. Insert the new RAM module at a 45° angle and snap down.

7. Unscrew and remove the retaining clip that secures the internal 
compact flash card.

8. Pull out the internal compact flash card. 

9. Insert the new internal compact flash card.

10. Reattach the retaining clip.

11. Attach the logic module by aligning the two connectors on the 
bottom of module with the connectors on the display module. 

12. Push down on the logic module until firmly seated.

13. Tighten the six captive screws that secure the logic module to a 
torque of 0.68 Nm (6 to 8 in-lb).

ATTENTION Wear a properly grounded ESD wristband 
before touching any of the electronic 
components in the logic module.

Skip Steps 5 - 6 if not replacing RAM. 

Compact Flash Card

Retaining Screw

RAM Module
Retaining 
Clips

Skip Steps 7 - 11 if not replacing internal 
compact flash. 
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Replace the Battery A lithium battery is used by the real-time clock; it is not used for 
application backup or retention. The clock module has a minimum 
life expectancy of two years without power. 
 

To replace the battery:

1. Disconnect power from the terminal.

2. Place the terminal, display side down, on a flat stable surface.

3. Detach the communication module (if attached) from the logic 
module by removing the four screws.

4. Loosen the six captive screws that attach the logic module to the 
display module.

WARNING When you connect or disconnect the battery an 
electrical arc can occur. This could cause an 
explosion in hazardous location installations. Be sure 
that power is removed or the area is nonhazardous 
before proceeding. 

For Safety information on the handling of lithium 
batteries, including handling and disposal of leaking 
batteries, see Guidelines for Handling Lithium 
Batteries, publication AG 5-4. Replace the battery 
only with the indicated catalog number.

Do not dispose of battery in a fire or incinerator. 
Dispose of used batteries in accordance with local 
regulations.

Store batteries in a cool, dry environment. We 
recommend 25 °C with 40 to 60% relative humidity. 
You may store batteries for up to 30 days between 
-45 to 85 °C, such as during transportation. To avoid 
possible leakage, do not store batteries above 60 °C 
for more than 30 days.

Captive screws 
on top and bottom

Logic Module
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5. Carefully lift the logic module away from the terminal and flip 
over to expose the circuit board.

6. Locate the battery on the circuit board.

7. Remove the battery by lifting up the side of the battery.

8. Insert the new battery. 

9. Attach the logic module by aligning the two connectors on the 
bottom of the module with the connectors on the terminal. 

10. Push down on the logic module until firmly seated.

11. Tighten the six captive screws that secure the logic module to a 
torque of 0.68 Nm (6 to 8 in-lb).

12. Attach the communication module (if necessary) and tighten the 
four screws to a torque of 0.68 Nm (6 to 8 in-lb).

ATTENTION Wear a properly grounded ESD wristband 
before touching any of the electronic 
components in the logic module.

Lift up the edge of the battery 
indicated by the arrow.
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Replace the Bezel Remove the Display Module Bezel
It is not necessary to remove the logic or communication module 
before removing the bezel, except for the VersaView CE 700H.

1. Disconnect power from the terminal.

2. Set the terminal, display side down, on a flat stable surface.

3. On touch screen only terminals, remove the two screws that 
secure the small metal plate to the back of the display module.

4. Disconnect the (touch screen) connector.

5. Remove the screws from the back of the display module. The 
number of screws varies for each terminal type.

6. Remove the sealing gasket.

ATTENTION Wear a properly grounded ESD wristband 
before touching any of the electronic 
components in the logic module.

Plate

Touch Screen Connector

Display Module Bezel
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7. Lift the back of the display module away from the bezel.

Work on a clean, flat, stable surface to protect the display from 
debris, scratches and damage.

8. Detach all connectors (maximum of three). The number of 
connectors varies by model. 
• IrDa connector (if present)
• Function key connector
• Touch screen connector

9. Set the bezel aside.

Replacing Display Module Bezel
1. Make sure the bezel is free of lint and marks before attaching.

2. Attach the connectors. The number of connectors varies by 
model. 

• IrDa connector (if present)

• Function key connector

• Touch screen connector

3. Place the back of the display module over the new bezel. Be 
careful not to pinch any of the cables. 

Allow the touch screen connector to extend out of the access 
opening.

4. Attach the touch screen connector.

5. Replace the sealing gasket.

6. Attach the screws that secure the display module to the bezel 
and tighten to a torque of 1.35 - 1.58 Nm (12 to 14 in-lb).

7. On touch screen terminals, reattach the small metal plate to the 
back of the display module using two screws and torque to  
0.68 Nm (6 to 8 in-lb).

Display Module Bezel
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Replace the Backlight This section shows how to replace the backlight for the 700H, 1000H, 
1250H, and 1500H terminals. The 1250H High-Bright terminals do not 
have a replaceable backlight.

1. Disconnect power from the terminal.

2. Remove the display module bezel.

3. Remove the four screws that secure the LCD display.

4. Lift the LCD display and detach the display connector from the 
circuit board. The location of the connector varies by model.

5. Detach the backlight connectors from the circuit board.

The 1250H has one or two backlight connectors depending on 
the display series. The 1500H has four backlight connectors. 

Display
Connector

Backlight
Connector

1250 1500
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For VersaView CE 700H and 1000H
Work on a clean, flat, stable surface to protect the display from 
debris, scratches and damage. 

6. Press the retaining tab that secures the backlight and then pull 
out the backlight.

7. Insert the new backlight.

Backlight 
Retaining Tab

Backlight 
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For VersaView CE 1250H and 1500H
• The 1250H Series A and B displays have two backlights and use 

cat. no. 2711P-RL12C backlight replacement.

• The 1250H Series C displays have only one backlight and use 
cat. no. 2711P-RL12C2 backlight replacement.

• The 1500H Series B displays have four backlights and use  
cat. no. 2711P-RL15C backlight replacement.

Work on a clean, flat, stable surface to protect the display from 
debris, scratches and damage.

8. Remove the screw(s) that secure the backlight(s) and then 
remove the backlight(s). 

• The two backlights for the 1250H Series A and B displays are 
each secured with two screws. 

• The single backlight for the 1250H Series C displays is 
secured with one screw.

• For the 1500H Series B displays, remove the tape and then 
remove the backlights.

9. Insert the new backlight(s) and then secure each with the same 
screws. Torque the screws to 0.117 Nm (1.04 in-lb).

Backlights

1250H

1500H
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10. Reattach the LCD display connector to the circuit board.

11. Reattach the backlight connector to the circuit board.

12. Secure the LCD display by attaching the four screws and tighten 
to the specified torque.

13. Replace the display module bezel.

Install the Remote AC 
Power Supply

Connecting to AC power requires a separate power supply, cat. no.  
2711P-RSACDIN that mounts to a DIN Rail. This power supply 
converts AC power to DC power and has these electrical input ratings:

• 85 to 264 V AC (47 to 63 Hz)

For details on installation, refer to the installation instructions shipped 
with the power supply.

Remove the Product Label If you ordered a terminal with a label, you can remove it and attach 
your own label. 

1. Remove the Allen-Bradley label using your fingers or a tweezers.

2. Clean area with damp cloth and isopropyl alcohol.

3. Remove adhesive backing of OEM label and affix over area 
where Allen-Bradley label was located.

Screw Size Torque

#4 .68 Nm (6 to 8 in-lb)
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Install the Keypad Legend 
Inserts

This section shows how to replace the legend inserts in the keypad 
terminals. The legend strips are available as separate catalog numbers 
for each keypad version of the terminals. One side of the legend strips 
have the default key legends and the other side is blank for creating 
custom legends. 

The F1-Fxx and K1-Kxx legend inserts on the VersaView CE 700H - 
1500H terminals are accessible when the display module bezel is 
removed.

To replace the F1-Fxx or K1-Kxx function key legends:

1. Remove power from the terminal.

2. Remove the display module bezel.

3. Pull the legend inserts out from the slots on the bezel.

4. Slide the new inserts into the same slots until only the end tab is 
visible.

5. Replace the display module bezel.
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Use an External Compact 
Flash Card

The terminal has a compact flash card slot which supports Type I 
compact flash cards. The cards are available in different memory sizes. 

The card slot is on the logic module. The orientation of the card slot 
varies depending on the Series of the logic module. 

Insert a Compact Flash Card

1. Insert the card in the compact flash card slot of the terminal until 
firmly seated.

Compact Flash Card Slot
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Remove a Compact Flash Card

1. Press the Eject button on the logic module.

The location of the Eject button varies depending on the series 
of the logic module.

2. When the button pops out, press it again to release the card. 

3. Remove the card from the card slot.
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Chapter 7

Terminal Connections

Chapter Objectives This chapter provides network and device connections for the 
terminals, including:

• Wiring and safety guidelines

• Logic controller cable charts

• Communication port isolation

• USB ports

• Serial connections on base unit

• Ethernet (onboard communications)

• DH485/DH+/RIO communications module

• ControlNet communications module 

• DeviceNet communications module 

Wiring and Safety 
Guidelines

Use publication NFPA 70E, ‘Electrical Safety Requirements for 
Employee Workplaces’, IEC 60364 ‘Electrical Installations in Buildings’ 
or other applicable wiring safety requirements for the country of 
installation when wiring the devices. In addition to the NFPA 
guidelines:

• route communication cables to terminal by a separate path from 
incoming power:

• Cross power and communication lines at right angles if they 
must cross.

Communication lines can be installed in the same conduit as 
low level DC I/O lines (less than 10V).

• Shield and ground cables appropriately to avoid Electromagnetic 
Interference (EMI).

Grounding minimizes noise from EMI and is a safety measure in 
electrical installations. 

For more information on grounding recommendations, refer to the 
National Electrical Code published by the National Fire Protection. 

IMPORTANT Do not run signal wiring and power wiring 
in the same conduit.
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Logic Controller Cable 
Charts

The charts provide a summary of terminal connections to controllers 
and network interface modules.

Runtime Communication Cables - To Controllers

Cables: VersaView CE to SLC Controllers

Protocol VersaView CE Comm Port
SLC-500, 5/01, 5/02

CH1 RJ45 
(DH-485)

SLC-5/03, 5/04, 5/05
CH0 (9-pin RS-232)

(DF1 or DH-485)

SLC 5/03
CH1 (RJ45)

(DH-485)

SLC 5/04
CH1 (DH+)

SLC 5/05
CH1 (ENET)

DF1
(any)

RS-232 (DF1) Comm Port (9-pin)
VersaView CE 700H -1500H N/A

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

N/A N/A N/A

DH-485 Serial
(any)

RS-232 (DH-485) Comm Port (9-pin)
VersaView CE 700H -1500H

use AIC+ Module
(1761-NET-AIC)

Connect to Port 1 or 2

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

use AIC+ Module
(1761-NET-AIC)

Connect to Port 1 or 2
N/A N/A

DH-485
xxx6xx

DH-485 Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

1761-CBL-AS03
 (10 ft/3m)

1761-CBL-AS09
 (30 ft/9m)

use AIC+ Module
(1761-NET-AIC)

Connect to Port 3

1761-CBL-AS03
 (10 ft/3m)

1761-CBL-AS09
 (30 ft/9m)

N/A N/A

ControlNet
xxx15xx

ControlNet Communication Port
VersaView CE 700H -1500H
6182H-xxx15xx, 2711P-RN15S

N/A 1747-KFC15A or
1747-SCRNR/A Module with ControlNet cable

DeviceNet
xxx10xx

DeviceNet Communication Port
VersaView CE 700H -1500H
6182H-xxx10xx, 2711P-RN10H

N/A Use 1747-SDN Module
with DeviceNet Cable

EtherNet/IP
(any)

EtherNet/IP Communication Port
VersaView CE 700H -1500H

N/A Use 1761-NET-ENI Module with 
Ethernet cable N/A N/A

2711P- 
CBL-EX04 
Ethernet 

Crossover 
Cable(1)

Remote I/O
xxx6xx

Remote I/O Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

SLC 5/02 only
use 1747-SN with

shielded twinaxial cable 
use 1747-SN Module with shielded twinaxial cable

DH+
xxx6xx

DH+ Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6 N/A N/A N/A

shielded
twin axial

cable
(1770-CD)

N/A

(1) VersaView CE EtherNet/IP direct connection to SLC-5/05 requires hub or the crossover cable listed.
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Cables: VersaView CE to PLC-5 and MicroLogix Controllers

Protocol VersaView CE Comm Port
PLC-5, PLC-5C, PLC-5E

CH0 (25-pin RS-232)
(DF1)

MicroLogix 1500LRP
CH1 (9-pin RS-232)

(DF1 or DH-485)

MicroLogix 1000, 1200, 
1500LSP

CH0 (8-pin Mini DIN)
(DF1 or DH-485)

DF1
(any)

RS-232 (DF1) Comm Port (9-pin)
VersaView CE 700H -1500H

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

(9-to-25 pin adapter required)

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

2711-NC21 (16ft/5m)
2711-NC22 (49ft/15m)

(null modem not required)(1)

DH-485 Serial
(any)

RS-232 (DH-485) Comm Port (9-pin)
VersaView CE 700H -1500H N/A

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

2711-NC21 (16ft/5m)
2711-NC22 (49ft/15m)

(null modem not required)(1)

DH-485
xxx6xx

DH-485 Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

N/A N/A
use AIC+ Module
(1761-NET-AIC)

Connect to Port 3

ControlNet
xxx15xx

ControlNet Communication Port
VersaView CE 700H -1500H
6182H-xxx15xx, 2711P-RN15S

to PLC-5C with
ControlNet cable N/A N/A

DeviceNet
xxx10xx

DeviceNet Communication Port
VersaView CE 700H -1500H
6182H-xxx10xx, 2711P-RN10H

Use 1771-SDN Module
with DeviceNet Cable N/A N/A

EtherNet/IP
(any)

EtherNet/IP Communication Port
VersaView CE 700H -1500H

to PLC-5E with
Ethernet cable

Use 1761-NET-ENI Module 
with Ethernet cable

Remote I/O
xxx6xx

Remote I/O Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

shielded twinaxial cable 
(1770-CD) N/A N/A

DH+
xxx6xx

DH+ Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

shielded twinaxial cable 
(1770-CD) N/A N/A

(1) AIC+ Module recommended for isolation purposes when VersaView CE and controller are not on same power supply

Cables: VersaView CE to Logix Controllers

Protocol VersaView CE Comm Port
ControlLogix

CH0 (9-pin RS-232)
(DF1)

CompactLogix
CH0 (9-pin RS-232)

(DF1 or DH-485)

FlexLogix
CH0 (9-pin RS-232)

(DF1)

DF1
(any)

RS-232 (DF1) Comm Port (9-pin)
VersaView CE 700H -1500H

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

DH-485 Serial
(any)

RS-232 (DH-485) Comm Port (9-pin)
VersaView CE 700H -1500H

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

DH-485
xxx6xx

DH-485 Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

N/A
use AIC+ Module
(1761-NET-AIC)

Connect to Port 3
N/A

DeviceNet
xxx10xx

DeviceNet Communication Port
VersaView CE 700H -1500H
6182H-xxx10xx, 2711P-RN10H

Use 1756-DNB Module
with DeviceNet Cable

Use 1769-SDN Module
with DeviceNet Cable

Use 1788-DNBO Module
with DeviceNet Cable

ControlNet
xxx15xx

ControlNet Communication Port
VersaView CE 700H -1500H
6182H-xxx15xx, 2711P-RN15S

use 1756-CNB Module with
ControlNet cable

1769-L35C
with ControlNet cable

use 1788-CNC or 1788-CNF 
Module with ControlNet cable

EtherNet/IP
(any)

EtherNet/IP Communication Port
VersaView CE 700H -1500H

use 1756-ENET or 
1756-ENBT Module with

Ethernet cable

to 1769-L35E
with Ethernet cable

use 1788-ENBT Module
with Ethernet cable

Remote I/O
xxx6xx

Remote I/O Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

use 1756-DHRIO Module 
with

shielded twinaxial cable 
(1770-CD)

N/A N/A

DH+
xxx6xx

DH+ Communication Port
VersaView CE 700H -1500H
6182H-xxx6xx, 2711P-RN6

use 1756-DHRIO Module 
with

shielded twinaxial cable 
(1770-CD)

N/A N/A
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Cables: VersaView CE to Communication Adapters

1747-AIC

1761-NET-AIC

Protocol VersaView CE Comm Port Port 1  (9-pin) Port 2
8-pin Mini DIN()

Port 3
(DH485)

1761-NETDNI
or 1771-NET-ENI

DF1 (any) RS-232 Comm Port (9-pin)
VersaView CE 700H -1500H N/A

2711-NC13 (16ft/5m)
2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

2711-NC21 (16ft/5m)
2711-NC22 (49ft/15m) N/A

1761-CBL-AP00 (0.5 m)
1761-CBL-PM02 (2m)
2711-CBL-PM05 (5 m)
2711-CBL-PM10 (10m)

DH-485 Serial
(any)

RS-232 Comm Port (9-pin)
VersaView CE 700H - 1500H N/A 2711-NC13 (16ft/5m)

2711-NC14 (32ft/10m)
2706-NC13 (10ft/3m)

2711-NC21 (16ft/5m)
2711-NC22 (49ft/15m) N/A

DH-485
xxx6xx

DH-485 Communication Port
VersaView CE 700H - 1500H
6182H-xxx6xx, 2711P-RN6

Direct Connection to 
single AIC with Belden 

9842 cable (1)
N/A

Direct Connection to 
single AIC+  with 

Belden 9842 cable (1)

N/A

(1) Use serial port on terminal with AIC+ module for a DH-485 network solution.
Publication 6182H-UM001D-EN-P - September 2005



Terminal Connections        7-5
Communication Port 
Isolation

The terminals contain integral and modular (externally attached) 
communication ports. These ports may contain electrical isolation 
depending on the catalog number of the terminal or communication 
module.

Integral Communication Port Isolation

700H - 1500H Modular Communication Port Isolation

Communication Port 700H-1500H Terminal

RS-232 Isolated

USB Non-isolated

Ethernet Non-isolated

Communication Port Module Isolation

DH-485 2711P-RN6 Non-isolated

DH+ 2711P-RN6 Non-isolated

Remote I/O 2711P-RN6 Non-isolated

DeviceNet 2711P-RN10H Isolated

ControlNet 2711P-RN15S Isolated (1)

(1) NAP port is non-isolated.
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USB Ports The terminal has two USB ports. The Windows CE .NET operating 
system currently only supports standard USB keyboard and mouse 
devices (that is, HID devices) with native device drivers. It also 
supports some USB printers that have Printer Control Language (PCL) 
capabilities. A vendor-specific Windows CE .NET driver will be 
required for all other USB devices.

See Appendix C for a list of compatible USB devices.

Plug the USB device into either one of the two USB ports on the 
terminal. 

USB Connector Pinout

 If a USB hub is connected to the terminal, an externally powered USB 
hub is recommended. Before attaching devices to a USB hub, check 
that the power adapter is connected and powered on.

Pin Signal

1 USBVCC

2 USBD-

3 USBD+

4 USB-GND

WARNING Do not connect or disconnect the communication 
cable with power applied to the terminal, or the 
serial device on the other end of the cable. An 
electrical arc could cause an explosion in hazardous 
location installations. Be sure that power is removed 
or the area is nonhazardous before proceeding.

WARNING USB devices not powered by the USB port must be 
within the same enclosure and connected to a 
ground system common with the terminal, or the 
USB devices must be used with a USB hub that 
provides galvanic isolation.

4
3
2
1

4
3
2
1

USB Ports
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Serial Connections The base configured unit of all terminals has a multi-purpose serial 
RS-232 port that supports:

• DH-485 communications through a serial connection

• DF1 full duplex communications with controllers using direct 
connections or modem connections

• Third party point-to-point communications

• Application uploads/downloads

• Printing

The serial port on the base configured unit of the terminal is a 9-pin, 
male, RS-232 connector. The table shows the pinout descriptions for 
this port and how these pins map to the serial ports on the controllers. 

The maximum cable length for serial communications is:

• 15.24 m (50 ft) at 19200 baud 

• 152 m (500 ft) at 9600 baud 

VersaView CE RS-232 Port 
9-pin DCE

SLC
9-pin

PLC
25-pin

MicroLogix/ 
DNI 8-pin DIN

1

2 2 3 4

3 3 2 7

4 4 20

5 5 7 2

6 6 6

7 7 4

8 8 5

9
Connector Shell Chassis Gnd

WARNING Do not connect or disconnect the communication 
cable with power applied to the terminal, or the 
serial device on the other end of the cable. An 
electrical arc could cause an explosion in hazardous 
location installations. Be sure that power is removed 
or the area is nonhazardous before proceeding.

Serial  RS-232 Port

Base Configured Unit of VersaView CE 

15
69

Insert plastic tie wrap in the 
hole and use as strain relief for 
all attached cables.

RXD

TXD

DTR

COM

DSR

RTS

CTS
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Modem Connection

Wire or radio modem communications is possible between the 
terminal and controller. Each modem must support full duplex 
communications. Refer to your modem user manual for details on 
settings and configuration.

Constructing a Null Modem Cable

To construct a null modem cable, refer to the following pinout:

VersaView CE  
9-pin                

 9-pin                VersaView  CE  
9-pin                

25-pin

FG (Frame Ground) - - - 1 FG

TD (Transmit Data) 3 2 3 3 RD

RD (Receive Data) 2 3 2 2 TD

RTS (Request to Send) 7 8 7 5 CTS

CTS (Clear to Send) 8 7 8 4 RTS

SG (Signal Ground) 5 5 5 7 SG

DSR (Data Set Ready) 6 4 6 20 DTR

DTR (Data Terminal Ready) 4 6 4 6 DSR

DF1 Port

Optical Isolator

Modem

Modem

Controller

VersaView CE
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Computer or Printer Connections

The RS-232 serial port on the base configured unit of the terminals 
supports:

• Application uploads/downloads using a direct connection or

• Printing

Printer

RS-232 Port

RS-232 Port

9-pin male
1
2
3
4
5
6
7
8
9

TXD (Data Transmit)
RXD (Data Receive)

COM
DTR

DSR
RTS
CTS
NC

DCD
9-pin male
1
2
3
4
5
6
7
8
9

(pulled high to +12V)

NC

 

NC

NC

VersaView CE Port (DCE)
Printer/Computer Port (DTE)

Available Cables
Cat. No. 2711-NC13, 5 m (16.4 ft)
Cat. No. 2711-NC14, 10 m (32.7 ft)
Cat. No. 2706-NC13, 3 m (10 ft)

25-pin to 9-pin 
Adapter

(if required)

with Handshaking

RXD
TXD

COM

RTS
CTS

9-pin male
VersaView CE Printer Port (DCE)

2
3

9-pin
2
3
5

Printer/Computer Port (DTE)
25-pin

2
7

3

5

Upload/Download or Printer Cable without Hardware Handshaking

RXD
TXD
COM

Computer

Base Configured Unit of VersaView CE
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Ethernet Connections The base configured unit of the terminal has an Ethernet port that 
supports:

• EtherNet/IP communications 

• Third party Ethernet communications

• Network connections

• Application uploads/downloads

• Printing

• Web browsing

Ethernet Connector

The base configured unit of the terminals has an RJ45,  
10/100Base-T connector for EtherNet/IP or Ethernet TCP/IP network 
communications.

The table shows the connector pinouts.

Use point-to-point, 10/100Base-T cables with cross over pin-outs 
(such as 2711P-CBL-EX04) when connecting the Ethernet port on the 
terminal directly to a logic controller’s Ethernet port or a computer 
10/100Base-T port. Use standard Ethernet cables when connecting to 
a switch or hub.

Pin Pin Pin Name

Looking into RJ45 
Connector

1 TD+

2 TD-

3 RD+

4 NC

5 NC 

6 RD-

7 NC

8 NC

Shield Connection Chassis Gnd

Ethernet Port Use RS-232 serial port to 
transfer applications or print.

Insert plastic tie wrap in 
hole and use as strain relief 
for all attached cables.

1 8
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Cables

Category 5 shielded and unshielded twisted-pair cables with RJ45 
connectors are supported. If 100 Mbit/second data rates are used, we 
recommend that you use a shielded cable.  The shielded cable will 
help insure that industrial noise immunity levels are maintained. The 
maximum cable length between the terminal’s Ethernet port and a 
10/100Base-T port on an Ethernet hub (without repeaters or fiber) is 
100 meters (328 feet). In industrial applications, keep the cable length 
to a minimum.
 

WARNING Do not connect or disconnect any communication 
cable with power applied to this device or any 
device on the network. An electrical arc could cause 
an explosion in hazardous location installations. Be 
sure that power is removed or the area is 
nonhazardous before proceeding.
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DH-485/DH+/Remote I/O 
Module

Terminals with a DH-485/DH+/Remote I/O communication module 
support communications with these networks:

• DH+ networks

• DH-485 networks

• Remote I/O networks

You can communicate with only one network at one time.

Module Connections

IMPORTANT See your controller documentation for appropriate 
controller connections.

Allen
Bradley

DH485
1

2
3
4
5

6

3

2

1

DH+
  RIO

Remote I/O*

3. Clear
2. Shield/Drain
1. Blue

DH+*

3. Blue
2. Shield/Drain
1. Clear

1. Earth Ground
2. Shield/Drain
3. Signal Ground
4. Channel B
5. Channel A
6. Termination Resistance

LED Indicator

* Use a Belden 9463 twin axial or equivalent cable, cat. no. 1770-CD.
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DH+ Status Indicator

DH-485 Status Indicator

Remote I/O Scanner Mode Status Indicator

Condition Indication

off Channel is not online

blinking green Device is only node on the network.

solid green Device is online and receiving token.

blinking red Duplicate node

solid red Failed selftest

Condition Indication

off Channel is not online

blinking green Device is only node on the network.

solid green Device is online and receiving token.

blinking red Parity error

solid red Failed selftest

Condition Indication

off Channel is not online

blinking green At least one but not all adapters in 
the scanlist are not responding.

solid green All adapters in the scanlist are 
responding.

blinking red None of the adapters in the scanlist 
are responding.

solid red Failed selftest
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DH-485 Network Port Wiring

Use these instructions for wiring Belden cable. If you are using 
standard Allen-Bradley cables, see the Logic Controller Cable Charts.

Attaching RS-485 Connector to the Communication Cable

Attach the connector to the Belden #3106A or #9842 Cable as shown.

The table shows connections for Belden #3106A.

IMPORTANT A daisy-chained network is recommended. We do 
not recommend hybrid star/daisy chain networks as 
shown.

For this Wire/Pair Connect this Wire To this Terminal

Shield/Drain Non-jacketed Terminal 2 - Shield

Blue Blue Terminal 3 - (Common)

White/Orange White with Orange Stripe Terminal 4 - (Data B)

Orange with White Stripe Terminal 5 - (Data A)

Belden
#3106A or
#9842

Belden
#3106A or
#9842

Belden
#3106A or
#9842

Connector

Connector

Connector

Incorrect

Orange with White Stripes

White with Orange Stripes

Shrink Tubing
Recommended

Blue (#3106A) or
Blue with White Stripes (#9842) Drain Wire

6  Terminal
5   A
4   B
3   Common
2   Shield
1   Chassis Ground

Single Cable Connection

to Previous Device

to Successive Device

Multiple Cable Connection
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DH+ Network Connections

Use the Belden 9463 twin axial or equivalent cable (cat. no. 1770-CD), 
to connect a terminal to a DH+ link..

You can connect a DH+ link in two ways:

• Trunk line/drop line - from the drop line to the connector screw 
terminals on the DH+ connectors of the processor

• Daisy chain - to the connector screw terminals on the DH+ 
connectors on the processor

Follow these guidelines when installing DH+ communication links:

• Do not exceed these cable lengths:

– trunk line-cable length: 3,048 m (10,000 ft)

– drop-cable length: 30.4 m (100 ft)

The maximum cable length is determined by baud rate.

• Do not connect more than 64 stations on a single DH+ link.

VersaView CE

DH+ Port on Communication Module

• 82 Ω terminating resistor for 230.4K  
bits/sec

• 150 Ω terminating resistor for 57.6K 
and 115.2K bits/sec

Clear 3
Shield SH  2

Blue 1

Belden

To Controller

Terminating Resistor
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Remote I/O Connections

Use the Belden 9463 twin axial or equivalent cable (cat. no. 1770-CD), 
to connect a terminal to a Remote I/O scanner. The maximum cable 
length (link distance) is determined by the baud rate.

• 2,800 m (10,000 ft) for 57.6K baud

• 1,400 m (5,000 ft) for 115.2K baud

• 700 m(2,500 ft) for 230.4K

See Programmable Controller Wiring and Grounding Guidelines, 
Publication 1770-4.1. The user manual for the I/O scanner module 
also provides cabling information.

VersaView CE

Remote I/O Port on Communication Module

• 82 Ω terminating resistor for 230.4K  
bits/sec

• 150 Ω terminating resistor for 57.6K 
and 115.2K bits/sec

Blue 3
Shield SH  2

Clear 1

Belden

To Controller

Terminating Resistor
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ControlNet Module Terminals with a ControlNet communication module support 
communications and the transfer of applications between devices on a 
ControlNet network.

Related Information

For more information on ControlNet products, refer to these 
publications.

• ControlNet System Overview (Publication 1786-2.9)

• ControlNet System Planning and Installation Manual (1786-6.2.1)

• ControlNet Cable System Component List (AG-2.2)

• ControlNet Communications for PanelView Plus and VersaView 
CE Terminals (2711P-UM003)

The Rockwell Automation website www.rockwellautomation.com 
provides information and product descriptions of ControlNet 
products. Under the Products and Services heading, select 
Communications.

ControlNet Protocol

The terminals support Unscheduled and Scheduled messaging, 
Scheduled I/O, and redundant cabling with PLC-5C and ControlLogix 
controllers.

The ControlNet architecture supports multiple processors and up to 99 
nodes (via taps) anywhere along the trunk cable of the network.  
There is no minimum tap separation and you can access the 
ControlNet network from every node (including adapters).

Compatible ControlNet Controllers

A terminal with a ControlNet Module communicates with a PLC-5C 
(PCCC commands) or a ControlLogix processor (CIP protocol) using 
Unscheduled messaging. The following controllers are supported:

• ControlLogix using 1756-CNB module

• PLC-5/20C, -5/40C, -5/60C, -5/80C
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Minimum Requirements 

The following software and firmware must be installed on the 
development computer and the PanelView Plus terminal to configure 
and communicate with an Allen-Bradley controller on a ControlNet 
network.

ControlNet Unscheduled Communications

ControlNet Scheduled Communications

Software/Firmware VersaView CE 700H-1500H

RSView Studio v3.10 or later

RSView Machine Edition Runtime v3.10 or later

ControlNet Module Firmware 2711P-RN15S, Series A, Rev A (firmware v2.07 
or later) (1)

(1) This applies to terminals that are ordered as pre-configured units with the ControlNet module.

Requirements VersaView CE 700H-1500H

RSView Studio v3.20 or later

RSView Machine Edition Runtime v3.20.04 or later

RSNetWorx for ControlNet v5.11 or later

RSLogix 5000 v13.0 or later

ControlNet Module Firmware 2711P-RN15S, Series A, Rev C (firmware v3.08 
or later) (1)

(1) This applies to terminals that are ordered as pre-configured units with the ControlNet module.

WARNING The ControlNet Communications Module 
(2711P-RN15S) will not run with RSView ME 
firmware 3.20.04 or earlier. All ControlNet Modules 
with v3.07 firmware must be upgraded to v3.08 or 
later; otherwise, outputs may turn on an 
indeterminate state.
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ControlNet Connections

2711P-RN15S ControlNet Module

Pin NAP Signal
1 Signal Common
2 No Connection
3 TX_H
4  TX_L
5  RX_L
6 RX_H
7 No Connection
8 Signal Common
Shell Earth Ground

Allen Bradley
ControlNet

A

B

Channel A

Channel B

Pin 1

LED B 

LED A 

Network Access Port (NAP)
RJ-45 connector for temporarily 
connecting programming terminals 
to devices on a ControlNet network

Redundant BNC
Cable Connectors

ATTENTION Do not connect more than one ControlNet network 
to the communications module. If you attempt to 
connect a second network to the module, your 
communication system will operate erratically.
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NAP and Redundant Cables

Refer to the ControlNet Cable System Planning and Installation manual 
(Publication  1786-6.2.1) for descriptions of ControlNet components. 
For information on purchasing these items, refer to the Allen-Bradley 
ControlNet Cable System Component List (Publication AG-2.2). 

Connect the Module to the Network

You can connect the ControlNet Module:

• Directly to a ControlNet network, which requires a tap

• To a device already connected to the ControlNet network

Item Catalog Number

RG-6 quad-shield 1786-RG6

Coax repeater 1786-RPT, -RPTD

Coax taps 1786-TPR, -TPS, -TPYR, -TPYS

Network access cable 1786-CP

Coax tool kit 1786-CTK

Segment terminators 1786-XT

BNC connectors 1786-BNC, -BNCJ, -BNCP, -BNCJ1

IMPORTANT Do not connect to a network using both the 
redundant cable BNC connector and the Network 
Access Port (NAP).

WARNING When used in a Class I, Division 2, hazardous 
location, this equipment must be mounted in a 
suitable enclosure with proper wiring that complies 
with the governing electrical codes.

Do not connect or disconnect any communication 
cable with power applied to this device or any 
device on the network. An electrical arc could 
cause an explosion in hazardous location 
installations. Be sure that power is removed or the 
area is nonhazardous before proceeding.
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DeviceNet Module Terminals with a DeviceNet communication module support 
communication and the transfer of applications between devices on a 
DeviceNet network.

Related Information

For more information on DeviceNet products, refer to these 
publications.

• DeviceNet Selection Guide (Publication DNET-SG001)

• DeviceNet Media Design Installation Guide (DNET-UM072)

• DeviceNet Tips & Tricks (DNET-BR003)

The Rockwell Automation website www.rockwellautomation.com 
provides information and product descriptions of DeviceNet products. 
Under the Products and Services heading, select Communications.

DeviceNet Protocol

The terminals support DeviceNet Scheduled I/O only. DeviceNet 
allows direct connection of field devices such as lights, drives, and 
valves. It also provides a control architecture that supports multiple 
processors. DeviceNet is a trunk/drop or bus-based network that 
supports up to 64 nodes and operates at 125, 250, or 500 K baud.

Compatible DeviceNet Controllers

A terminal with a DeviceNet Module communicates with an SLC-500 
and PLC-5 (PCCC commands), or a ControlLogix processor (CIP 
protocol) using Unscheduled messaging. Supported controllers 
include:

• ControlLogix using 1756-DNB module

• PLC-5 with a 1771-SDN module

• SLC 5/03 - SLC/505 with a 1747-SDN module
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Minimum Requirements

DeviceNet Connections

2711P-RN10H DeviceNet Module

Software/Firmware PanelView Plus 700H-1500H

RSView Studio v4.0 or later

RSView Machine Edition Runtime v4.0 or later

DeviceNet Module 2711P-RN10H

WARNING Do not connect or disconnect any communication 
cable with power applied to this device or any 
device on the network. An electrical arc could cause 
an explosion in hazardous location installations. Be 
sure that power is removed or the area is 
nonhazardous before proceeding.

MOD Status Indicator

I/O Status Indicator

NET Status 
Indicator

Red 
White 
Shield 
Blue 
Black
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DeviceNet I/O Status Indicator

This bi-color (green/red) LED provides information on the states of 
inputs and/or outputs.

Condition Status Indication

off output(s) active All outputs are active.

input(s) active All inputs are active.

green output(s) active One or more outputs are active and 
under control, and no outputs are 
faulted.

input(s) active One or more inputs are active and 
producing data, and no inputs are 
faulted.

flashing green(1)

(1) The flash rate of the LED is approximately 1 flash per second. The LED should be on for approximately 0.5 
seconds and off for approximately 0.5 seconds.

output(s) idle One or more outputs are idle, and no 
outputs are active or faulted.

flashing red (1) output(s) faulted One or more outputs are faulted, and 
may be in the fault state.

input(s) faulted One or more inputs are faulted, and 
may be in the fault state.

red output(s) forced off One or more outputs are forced off 
(may be an unrecoverable fault).

input unrecoverable fault One or more inputs has an 
unrecoverable fault.
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DeviceNet Module (MOD) Status Indicator

This bi-color (green/red) LED provides device status. It indicates 
whether or not the device has power and is operating properly.

Condition Status Indication

off no power No power applied to device.

green device operational Device is operating in a normal 
condition.

flashing green(1)

(1) The flash rate of the LED is approximately 1 flash per second. The LED should be on for approximately 0.5 
seconds and off for approximately 0.5 seconds.

device in standby 
(device needs 
commissioning)

Device needs commissioning due to 
configuration missing, incomplete, or 
incorrect.

flashing red (1) recoverable fault For example, the device’s scan list 
configuration does match the actual 
network configuration.

red unrecoverable fault Device has an unrecoverable fault. 
Cycle power to your computer. If the 
problem persists, the device may 
need to be replaced. 

device self testing Device is in self test. Refer to the 
DeviceNet Specification, Volume II, 
Identity Object.
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DeviceNet Network (NET) Status Indicator

This bi-color (green/red) LED indicates the status of the 
communication link.

Condition Status Indication

off not powered Device is not online.

not online The device has not completed the 
Dup_MAC_ID test yet.

The device may not be powered; look 
at the Module Status LED.

flashing green(1)

(1) The flash rate of the LED is approximately 1 flash per second. The LED should be on for approximately 0.5 
seconds and off for approximately 0.5 seconds.

online Device is online, but has no 
connections in the established state.

not connected The device has passed the 
Dup_MAC_ID test, is online, but has 
no established connections to other 
nodes.

green link okay, online, connected The device is online and has 
connections in the established state.

flashing red (1) connection timeout One or more I/O connections are in 
the timed-out state.

red critical link failure Failed communication device. The 
device has detected an error that has 
rendered it incapable of 
communicating on the network 
(Duplicate MAC ID or Bus-off).

Check network integrity and baud 
rate of all devices. Then cycle power 
to the card by shutting down and 
cycling power to your computer.

ATTENTION Extensive use of Change-of-State connections, 
particularly with rapidly changing data, can adversely 
impact the available DeviceNet network bandwidth. 
If the network bandwith becomes consumed, some 
devices may only be able to communicate 
intermittently. This can result in timeout errors and 
possible loss of data. If timeouts occur, consider 
changing the connection type for some of the 
Change-of-State connections to Cyclic or Polled.
Publication 6182H-UM001D-EN-P - September 2005



7-26        Terminal Connections
Publication 6182H-UM001D-EN-P - September 2005



Chapter 8

Transfer Files

Chapter Objectives This chapter covers information on how to:

• Transfer applications using a compact flash card

• Transfer applications from a computer

• Connect to a computer using ActiveSync

• Upgrade terminal firmware

Transfer Files Using a 
Compact Flash Card

The VersaView CE terminal allows you to copy or load files using a 
compact flash card from Windows Explorer or RSView ME. 

• To copy files in RSView ME using a compact flash card, see page 
4-21.

• To copy files in Windows Explorer, see page 5-6.

Transfer Files from a 
Computer

Connect via ActiveSync This section shows how to create an ActiveSync connection between a 
computer and a VersaView CE terminal. 

Creating an ActiveSync connection is a two-step process:

1. Create a partnership between the devices using a Serial 
connection.

2. When the partnership is created, you can then connect the 
devices using an Ethernet.

What You Need

• Computer and a VersaView CE terminal that are connected to an 
Ethernet network supporting DHCP

• ActiveSync 3.7 (or later) software installed on computer. You can 
download ActiveSync from the www.microsoft.com website.

• 2711-NC13 or 2706-NC13 serial cable for connecting the 
VersaView CE terminal to the computer with ActiveSync 
installed. 

IMPORTANT For details on transferring .MER applications from a 
computer to the VersaView CE terminal, refer to 
RSView Studio help or documentation.
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Create a Partnership using a Serial Connection

Install ActiveSync on PC

1. Install ActiveSync 3.7 (or later) on your computer. 

2. Connect the VersaView CE terminal to the computer with 
ActiveSync installed. 

Use a 9-pin straight through cable (2711-NC13 or 2706-NC13) for 
a serial connection and/or an Ethernet cable.

3. Start ActiveSync. You will see the Get Connected screen.

Initiate Serial Connection on VersaView CE  

1. Select Start>Menu>Programs>Microsoft ActiveSync>Serial.

The Connecting to Async Connection dialog appears.

Find ActiveSync Connection and Create a Partnership on PC

1. When the Connecting to Async Connection dialog appears on 
the VersaView CE, select the Next button on the Getting 
Connected screen of your computer.

If the Connecting to Async Connection dialog closes before a 
connection is established, return to Initiating Connection from 
VersaView CE.

2. When the ActiveSync connection is created, a window opens 
allowing you to create a new partnership. Select Yes to create 
the new partnership.

3. ActiveSync will prompt you for a device name. Enter the name 
and press Next.

4. Select any options you want to synchronize. Press the Next 
button.

5. Press the Next button and then the Finish button.

IMPORTANT To complete the ActiveSync installation, you must 
select the Serial Connection initially. After that you 
can switch between serial and Ethernet.

You must also make a valid ActiveSync connection at 
least once with the computer. 
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Terminate Connection on VersaView CE

1. Click the ActiveSync connection utility on the taskbar. 

The Connection Status dialog should appear.

2. Press the Disconnect button to terminate the connection (may 
take 30 seconds).

Connect via Ethernet

Now that a partnership is created using a serial connection, you can 
connect to the VersaView CE using an Ethernet connection.

ActiveSync Setup on PC

1. Verify that ActiveSync is configured to accept Ethernet. By 
default, Ethernet is enabled. (It is only necessary to enable 
Ethernet if it is disabled).

Connect with the Partnership on VersaView CE

1. Select Start>Programs>Microsoft Active Sync>Ethernet.

The ActiveSync dialog opens. The name of the computer you 
connected to via the serial connection will appear. 

2. Select Connect.

The Connection Status window opens. This window remains 
opens as long as the ActiveSync connection is active. 

Closing the window will terminate the connection.
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Upgrade Firmware The Firmware Upgrade Wizard (FUW) allows you to upgrade 
firmware in the terminal. Using the FUW, you can:

• Create a firmware upgrade card (compact flash card) which you 
then load in the card slot of terminal to upgrade firmware.

• Upgrade firmware in a terminal that is connected to your 
desktop computer using a Serial, Ethernet, or Network 
connection via RSLinx Enterprise (for supported protocols).

The Firmware Upgrade Wizard is available in RSView Studio or with 
the Firmware Upgrade Kit. 

Prepare Terminal for Firmware Upgrade
Before starting the Firmware Upgrade Wizard, follow these steps to 
prepare the terminal for a successful upgrade.

1. Backup all .MER files on the terminal to an external storage card 
or network.

2. Delete all applications on the terminal.

3. Record any Ethernet communication settings, such as IP address, 
subnet masks, and gateways by selecting Terminal 
Settings>Network and Communications>Network 
Connections>Network Adapters>IP Address.

4. Disable the Auto-start feature on the terminal by selecting 
Startup Options>RSView ME Station Startup and select Go to 
Configuration Mode.

5. Reset the terminal.
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Upgrade Firmware using a Compact Flash Card

This section shows how to upgrade the firmware in terminal using a 
compact flash card. This is a two step-process. First, you create a 
firmware upgrade card with the necessary firmware files. Second, you 
load this card in the target terminal to upgrade the firmware.

1.  Create a Firmware Upgrade Card

1. Start the Firmware Upgrade Wizard. Select Start>Rockwell 
Software>RSView Enterprise>Firmware Upgrade Wizard.

2. Select Create firmware upgrade card.

• In the Firmware card location text box, select the destination for 
the compact flash files (folder on the hard drive or physical 
location of the compact flash card, e.g., E:\). 

• From the Existing terminal list, select the type of terminal you 
are upgrading, then press Next.
Publication 6182H-UM001D-EN-P - September 2005



8-6        Transfer Files
3. From the Firmware source folder list, select the location of the 
firmware files. The default location is C:\Program 
Files\Rockwell Software\RSView Enterprise\FUPs. 

From the Upgrade firmware version list, select the version of the 
firmware you want to upgrade to, then press Next.

4. Select the appropriate KEPServer drivers and press Next. If no 
KEPServer drivers are needed, just press Next.

TIP If the selected FUP file does not support the 
KEPServer drivers, this dialog will not appear.
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5. Select Finish to copy the firmware source files to the location 
specified in step 2.

2.  Upgrade Firmware in the Terminal using Firmware Upgrade Card

1. Insert the compact flash card into the card slot of a powered 
terminal. A dialog appears indicating the firmware upgrade is 
about to occur. 

2. Press Upgrade to begin the firmware upgrade. 

TIP If the files were created in a separate folder on 
a local hard drive, copy the files to the root 
directory of the compact flash card.

IMPORTANT Do NOT remove the compact flash card while the 
upgrade is in process.
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3. If other terminals exist on the same Ethernet network, the 
following error may display:

’Error registering name on network (may be duplicate). Change 
in system Control Panel and try again.’

Ignore this error. It will be corrected during the upgrade. Press 
OK to acknowledge error and wait for terminal to reset.

4. On touch or touch/screen terminals, you must calibrate the 
touch screen by selecting pointers in all four corners of the 
screen and pressing the middle of the screen when prompted.

5. Ignore the following message if it appears. It means RSView ME 
is being installed. Do not touch the two buttons that appear with 
this message.

’Machine edition may be corrupted. Do you want to download 
firmware?’

6. When the upgrade is complete, a dialog appears requesting you 
to remove the compact flash card from the card slot. Remove the 
card and press F8 or Exit to reset the terminal.

7. Communication settings are cleared when the terminal is 
upgraded. If Ethernet communications is used, reconfigure the 
Ethernet communication settings using the values recorded 
when preparing the terminal. 

8. Replace the .MER files that you backed up before starting the 
upgrade or download a new .MER file to the terminal.

9. Load the .MER file and run the project.

TIP If a USB mouse is available you can 
acknowledge this error by selecting OK.

TIP You can configure your application to start 
automatically on power cycle under Startup 
Options.
Publication 6182H-UM001D-EN-P - September 2005



Transfer Files        8-9
Upgrade Firmware using a Network (Ethernet) Connection

You can upgrade the firmware in a terminal that is connected to a 
desktop computer using a Serial, Ethernet or Network (using RSLinx 
Enterprise) connection.

• Serial connection requires a RAS connection to be set up on 
computer. During the RAS setup, you select the COM port. 

• Ethernet connection requires that you enter the terminal’s IP 
Address. 

• Network connection requires RSLinx Enterprise where you 
select the terminal on an existing network. 

Both the Serial and Ethernet connection requires the File Transfer 
Utility running on the terminal.

This section shows how to upgrade firmware in a terminal using a 
Network connection via Ethernet communications.

1. Start the Firmware Upgrade Wizard. Select Start>Rockwell 
Software>RSView Enterprise>Firmware Upgrade Wizard.
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2. Select Upgrade firmware on terminal and press OK.

3. Select Network connection and press Next.

Use the Ethernet and Serial connections only if the firmware 
upgrade is unsuccessful.

4. Locate the terminal on your Ethernet network via its IP address.

Skip to Step 6 if you found the terminal. If you do not see the 
terminal, right click on the Ethernet driver and add the device to 
the browse tree.
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5. Double-click on EthernetIP Devices. Select the appropriate 
terminal and press OK.

6. Enter the IP address for the terminal and press OK.

7. Select the terminal to be upgraded and press OK.
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8. From the Firmware source folder text box, select the location of 
the firmware files. The default location is C:\Program 
Files\Rockwell Software\RSView Enterprise\FUPs. 

From the Upgrade firmware version list, select the version of the 
firmware you want to upgrade to, then select Next.

9. Select the appropriate KEPServer drivers and select Next. If no 
KEPServer drivers are needed, just select Next.

TIP If the selected FUP file does not support the 
KEPServer drivers, this dialog will not appear.
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10. Press Finish to start the upgrade.

11. Press Yes to continue the upgrade process. If the terminal was 
properly prepared for the upgrade, no applications should be 
running.

12. Firmware files are downloaded to the terminal. This may take 
several minutes to 15 minutes. When the download is complete, 
press OK to reset the terminal. 

If other terminals exist on the same Ethernet network, the 
following error may display:

’Error registering name on network (may be duplicate). Change 
in system Control Panel and try again.’

Ignore this error. It will be corrected during the upgrade. Press 
OK to acknowledge error and wait for terminal to reset. 

TIP If a USB mouse is available you can 
acknowledge the error by selecting OK.
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13. On touch or touch/screen terminals, you must calibrate the 
touch screen by selecting pointers in all four corners of the 
screen and pressing the middle of the screen when prompted.

14. Ignore the following message if it appears. It means RSView ME 
is being installed. Do not touch the two buttons that appear with 
the message.

’Machine edition may be corrupted. Do you want to download 
firmware?’

15. Communication settings are cleared when the terminal is 
upgraded. If Ethernet communications is used, reconfigure the 
Ethernet communication settings using the values recorded 
when preparing the terminal. 

16. Replace the .MER files that you backed up before starting the 
upgrade or download the new .MER files to the terminal.

17. Load the .MER file and run the project.

TIP You can configure your application to start 
automatically on power cycle under Startup 
Options.
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Chapter 9

Troubleshooting

Chapter Objectives This chapter provides information on how to isolate and correct 
common operating problems.

• LED indicators

• General troubleshooting

• Troubleshooting individual components (display, touch screen, 
keypad, attached keyboard or mouse)

• Ethernet

• Application startup

• File system

• Advanced troubleshooting

• Startup error messages

• Startup information messages

• Startup sequence

• System identification errors

• Restarting in safe mode

• Firmware upgrades

• Clean the display window

LED Indicators The terminals have two LED indicators to isolate operating problems:

• COMM indicator (green) for communications

• FAULT indicator (red) for terminal faults

COMM and FAULT LEDs
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General Troubleshooting This section provides a list of general troubleshooting steps to follow 
when trying to isolate problems. 

• Check for adequate power. The VersaView CE terminal 
requires 24V dc at 2.9 A minimum. An under-powered unit 
could result in unpredictable behavior.

The AC power supply (2711P-RSACDIN) meets Class 2/SELV 
requirements, and is approved for the VersaView CE terminal.   

• Check LED indicators on the logic module at startup. Is   
power on? Is the unit attempting to start? The red LED should be  
Off, except for a few brief flashes, and the green LED should be 
On. If the LEDs remain Off, the power supply or logic module 
has failed. Check the power cable. Replace the logic module if 
the power is within range; if not, replace the power supply. 

If the terminal powers up and stops during startup, the state of 
the logic module LEDs indicate: 

Blinking red LED indicates a recoverable error. 

Solid red LED indicates a non-recoverable and fatal error. 

• Check the messages at startup for errors. Record any error 
message and refer to the Startup Error Message table.

• Check the voltages and temperatures. In VersaView CE, open 
the Hardware Monitor control application. In RSView ME, open 
Terminal Settings>System Information>Terminal Information.

– Battery Voltage should be at least 2.75 V dc. Replace the 
battery if less than 2.75 V dc.

– Display Temperatures should be less than 55 °C. The CPU 

temperature should be less than 95 °C. 

Red LED Green LED Indication

Blinking Off Last firmware download failed. Reload 
firmware using Firmware Upgrade Wizard 
(FUW) utility.

Blinking Blinking EBC boot loader firmware failed or is 
missing. Reload firmware using Firmware 
Upgrade Wizard (FUW) utility.

Blinking On Windows CE .NET OS firmware failed or is 
missing. Reload firmware using Firmware 
Upgrade Wizard (FUW) utility.

Red LED Green LED Indication

On Off Fatal hardware error occurred in logic module. 
Replace the logic module.

On Blinking Fatal hardware error occurred in display 
module. Replace the display module.

After a successful startup, both LEDs are 
off and controlled by the application 
running on the terminal. 
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If the temperatures are higher, check for obstructed airflow 
through the chassis and attempt to moderate the ambient 
temperatures within the enclosure and surroundings.

• Check the System Event Log for errors or unexpected 
reboots. In VersaView CE, open the Hardware Monitor 
application and select the Event Log tab. In RSView ME, open 
Terminal Settings>System Event Log.

• Use Extended Diagnostics to perform more extensive 
hardware testing at startup. In VersaView CE, open the 
Extended Diagnostics control panel application. In RSView ME, 
open Terminal Settings>Startup Tests>Select Tests.

Select one or more of the tests you want to run. Enable 
extended diagnostics and set the iteration or repeat count. 
Restart the terminal. The Serial Port test requires a loopback 
connector with these connections.

. 

Extended Diagnostics are performed at every startup until 
disabled. A failure will momentarily halt startup and display an 
error message. 

1
2
3
4
5
6
7
8
9

N/C
RX
TX
DTR
N/C
DSR
RTS
CTS
N/C

DB9 Connector (female)
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Troubleshooting 
Components

This section provides tips on how to isolate problems with individual 
components of the terminal, including the display, touch screen, 
keypad, attached keyboard or mouse.

Display Problems

This section provides tips on how to isolate problems with the 
display.

• Check the brightness setting of the display module. Is the 
display brightness dim or unreadable? 

In VersaView CE, open the Display control panel application 
and select the Backlight tab. In RSView ME, open Terminal 
Settings>Display Intensity.  

• Check the Screen Saver settings. Is the backlight turning off 
and dimming the display unexpectedly.

In VersaView CE, open the Display control panel application 
and select the Screen Saver tab. In RSView ME, open Terminal 
Settings>Display>Screen Saver. 

• Check the LED indicators on the logic module. Do they flash 
during startup? Is power on and is the unit attempting to start?

• Check the Display temperature. The display intensity will 
decrease to 40% if its temperature (or the temperature within the 
enclosure) is too high to reduce damage to the display. This can 
be checked using the RSView ME Events log.

• Check the startup messages. Is the display operating at all and 
do the startup messages appear? Record any error message and 
refer to the Startup Error Messages.

• Restart in Safe Mode. If the startup messages appear on the 
display but the Windows CE .NET operating system appears to 
be failing, try booting up in Safe Mode. See page 9-16 for details. 
If the unit appears to run in Safe Mode then it is likely that the 
WinCE Registry is corrupt or a bad application is being loaded 
automatically at startup.

• Replace the display module if all other attempts do not 
resolve problem. If replacing the display corrects the problem, 
then the display was not functioning properly. 

Touch Screen Problems

This section provides tips on how to isolate problems with the touch 
screen.
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• Check the catalog number of the unit. Verify that your 
terminal has a touch screen by looking at the label on the 
display module.

• Perform a calibration of the touch screen. In VersaView CE, 
open the Touch control panel application and select the 
Calibration tab. In RSView, open Terminal Settings>Input 
Devices>Touch Screen>Calibration. Follow the directions.

The calibration requires 4 user screen touches. When the 
touches do not converge to a satisfactory calibration, you are 
asked repeatedly for additional screen touches and the 
calibration process never terminates. A touch screen that does 
not calibrate is not present or not functioning properly. Replace 
the bezel or the display module.

• Check the Cursor Enable setting for the touch screen. Is the 
cursor visible?   In VersaView CE, open the Display control panel 
application and select the Cursor tab. In RSView, open Terminal 
Settings>Input Devices>Touch Screen>Cursor.

• Check the pointer input by attaching a USB mouse. If the 
mouse works, but the touch screen does not, then the touch 
driver or touch screen is not functioning properly. If both the 
mouse and the touch screen are not working, then it is an 
application problem.

• Determine if the problem is with the application. Try to 
touch something outside the application such as a button in the 
shell or a desktop icon. If the touch screen operates outside the 
application, then the application is the problem.

• Does touching or dragging on the screen appear to work? 
If yes, even if incorrectly, the touch screen is present and 
working but requires calibration. 

• Replace the bezel or display module if all other attempts 
do not resolve the problem. If replacing the display module 
or bezel corrects the problem, then the touch screen was not 
functioning properly.
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Mouse Problems

This section provides tips on how to isolate problems with an 
attached mouse.

• Check the Cursor Enable setting. Is the cursor visible? In 
VersaView CE, open the Display control panel application. In 
RSView, open Terminal Settings>Input Devices>Touch 
Screen>Cursor. Also check mouse settings.

• Check the USB cable and connection. Detach and then 
re-attach the mouse. Cycle power to the terminal.

• Is the mouse a USB composite device? If the mouse is a 
keyboard/mouse composite device, then try a stand-alone USB 
mouse.

• Replace the USB mouse. Try a different model or 
manufacturer. See Appendix C for a list of compatible USB 
devices. You can also check the Knowledgebase at the 
http://support.rockwellautomation.com site for a list of USB 
devices that are compatible with the terminal. If attaching a new 
mouse resolves the problem, then the old mouse was not 
working or non-compliant. 
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Keypad Problems

This section provides tips on how to isolate problems with the 
Keypad.

• Check the Multi-Key/Hold-Off settings. In VersaView CE, 
open the Keypad control panel application. In RSView, open 
Terminal Settings>Keypad>Keypad Settings. 

Is the Hold-Off Delay longer than expected, or are multiple key 
presses inhibited by Multi-Key Lockout? Check all configurable 
settings.
The Home, End, Page Up, and Page Down keys are not 
supported when multi-key lockout is enabled.

• Check the key input by attaching a USB keyboard. If the 
keyboard works, but the keypad does not, then the keypad 
driver or keypad is not working. If both the keypad and 
keyboard are not working, then the problem may be the 
application.

• Check the keypad mapping?  Keys on the VersaView CE 
terminal can be remapped and/or disabled via the Keypad 
Configuration Utility (KCU). Use the KCU to check the current 
keypad configuration. Restarting in Safe Mode will result in the 
default keypad mappings.  

• Determine if the problem is with the application. Press a 
key outside the application such as an edit box in the shell. If 
the  keypad input works outside the application, then the 
application is at fault. On the VersaView CE terminal, press 
Ctrl+Esc simultaneously to open the Start menu, cursor to run, 
type numbers and viewable characters into the Run dialog.

• Replace the display module if all other attempts do not 
resolve problem. If replacing the display module corrects the 
problem, then the keypad was not functioning properly.  
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Problems with Keyboard

This section provides tips on how to isolate problems with an 
attached Keyboard.

• If the keypad is present, check input using the keypad. If 
the keypad works, but the keyboard does not, then the 
keyboard driver or keyboard is probably not working. If both 
the keypad and the keyboard are not working, then it is 
probably an application problem.

• Determine if the problem is with the application. Press a 
key outside the application, such as an edit box in the shell. If 
keyboard entry works outside the application, then the 
application is the problem. On VersaView CE, press Ctrl+Esc 
simultaneously to open the Start menu, cursor to run, type 
viewable characters into the Run dialog.

• Check the USB cable and connector. Detach and re-attach the 
keyboard. Insure a good connection. Cycle power to the 
terminal.

• Is the keyboard a USB composite device? If the keyboard is a 
keyboard/mouse composite device, then try a stand-alone USB 
keyboard.

• Replace the USB keyboard. Try a different model or 
manufacturer. See Appendix C for a list of compatible USB 
devices. You can also check the Knowledgebase at the 
http://support.rockwellautomation.com site for a list of USB 
devices that are compatible with the terminal. If a new keyboard 
resolves the problem, then the old keyboard was probably 
non-compliant.  
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Ethernet Problems • Check the LED indicators at the Ethernet connector. The 
green LED indicates a communications link and should be ON. 
The amber LED indicates data activity and should be flashing. 
Verify that there is a connection to the hub.

• Check the cable connections and quality of cable. Check for 
good connections and things such as quality, crimping, hub 
connection, and uplink ports.

• Check the IP Address of the Built-In Ethernet Controller. In 
VersaView CE, open the Network and Dial-up Connections 
control panel application. In RSView, select Terminal 
Settings>Networks and Communications>Network 
Connections>Network Adaptors.

If DHCP is enabled, the device expects a valid IP address to be 
acquired within several seconds after startup. The TCP/IP 
protocol automatically assigns 169.254.nnn.nnn when it fails to 
acquire an IP address from the server. In general, an IP address 
that begins with 169 will not support a network connection.

A bad Ethernet connection and the absence of a valid IP address 
are typically reported in a Communications error message box 
with the Winsock critical error 10065 - "No route to host".

• Check for conflicting IP addresses. If DHCP is not enabled, 
make sure the IP address you specify is not in conflict with the 
address of another device on the network.

• Check the Device Name of the terminal. Do not allow 
devices on the network with same (host) name. In VersaView 
CE, open the System control panel application. In RSView, open 
Terminal Settings>Communications and Networks>Network 
Connections>Device Name. 

• Contact your Network Administrator to check peer or 
server settings. The “other side” of the Ethernet connection 
may also be a problem.

• Use the network utilities Ping.exe and Ipconfig.exe.

• Check the requirements of network applications.  Network 
applications may have specific requirements such as Proxy 
Settings for Internet Explorer and Ethernet Configuration for 
ActiveSync. In VersaView CE, open the Communications control 
panel application.

• Check the multi-homed devices. Multi-homed (more than 1 
Ethernet node) devices have the same issues as those above but 
with more potential for confusion and ambiguity. Keep the 
Network connections as simple as possible.
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Application Startup 
Problems

• Application does not run on startup. If the application does 
not run at startup, try to run the application manually. If the 
application runs manually, then the operating system may be 
starting up with an invalid shortcut path.

Check the shortcuts in the folder:

 \Storage Card\Windows\StartUp

Check the syntax of each shortcut path in the Startup folder and 
insure that a valid target application exists.

• Is the application missing components?  The application 
may be missing components or required DLLs.

• Remove and re-load the application.

File System Problems • File system errors are reported at startup. The file system is 
checked at startup and errors are reported in a message box. 
Record the error information and always elect to correct the 
problem. Typically, the message box will reappear until the 
error is corrected.

File system errors are rare and can usually be corrected. The 
most common cause of lost clusters and file/directory size 
mismatches within a FAT file system is an unexpected power 
outage while writing to the file system. Always stop applications 
before removing power so that data is cleanly flushed out to the 
file system and the file system is brought to an orderly stop.

Although, the RSView ME application runs from RAM, 
applications such as data and event logging, and historical 
trending, write to flash memory and should be stopped before 
removing power. 

Advanced Troubleshooting 1. Ping and ipconfig are invaluable for network debugging along 
with some knowledge of IP and the Winsock error codes. 

• Try to ping the destination host.

• Check the destination address. 

• Check whether you have a router configured in your network 
system (your WinSock implementation). 

• Use the tracert command at the command prompt on the 
desktop to try and determine where the failure occurs along 
the route between your host and the destination host.
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2. Some utility programs are distributed on the Accessories CD.  
Others can be developed using the SDK (Software Development 
Kit).

3. Take advantage of alternate connectivity - mouse versus touch 
screen, keyboard versus keypad, serial communications, and 
alternate Ethernet connections.

4. Enable the crash logger and examine the EXCEPTIONS.LOG file 
from the VersaView CE when suspecting an operating system or 
application crash.

5. Store the current operating system on an external compact flash 
card. You can then use this card to update the terminal in case 
the operating system is out-of-date or corrupted. 

6. Store Autorun.exe utilities on an external compact flash card 
which can be easily run by inserting the card in the external 
compact flash card slot of the terminal. 

7. Know useful keyboard shortcuts so that you can navigate 
around the system without a mouse or touch screen.

8. Check the Event Log in the Hardware Monitor control panel 
application or under Terminal Settings>System Event Log in 
RSView ME. Look for error conditions or reasons for unexpected 
reboots.

9. Check the configuration settings in the VersaView CE Control 
Panel applications or RSView ME for incorrect settings. 

10. Most importantly, general troubleshooting thoroughness means 
getting answers to questions such as:

• Does the failure always happen?  Is it repeatable?

• Does the failure happen at bootup or some other time? Is 
there a set of actions that reveal the problem?

• Does the failure occur on just one terminal or multiple 
machines?  If more than one machine, what do they have in 
common?  If not all machines, then what is different between 
machines that fail and those that don’t?

• What appears on the screen, the LED indicators?

• Lastly, and most important; did everything work until 
recently? If so, what changed? 
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Startup Error Messages The table provides a list of system error messages that may display on 
startup and the recommended corrective action. The messages apply 
to all terminals except where indicated. When an error occurs, the 
terminal displays the error number with a text message. The word 
ERROR! appears under this line in different languages.

#  Displayed Message 
ERROR!  FEHLER!  ERREUR!  ERRORE!

Error # Displayed Message Description Recommended Action

1 RAM Test RAM test failure Reset the terminal. If error persists, reseat 
the SO-DIMM RAM module. If error still 
persists, replace the logic module.

23  Internal CF Error programming the new OS 
firmware to internal compact flash.

Reload the firmware. If error persists, 
replace the internal compact flash. If error 
still persists, replace the logic module.

24 CRC Check Checksum of the OS firmware failed. Reload the firmware. If error persists, 
replace the internal compact flash card. If 
error still persists, replace the logic 
module.

30 Watchdog Test Watchdog test failure Reload the firmware. If error persists, 
replace the logic module.

31 Stuck Key Function key failure Check that nothing is pressed against a 
key. Reset the terminal without key 
presses. If error persists, replace the 
display module.

31.5 Stuck Touch Touch screen failure Check that nothing is pressed against the 
touch screen. Reset the terminal without 
touch screen presses. If error persists, 
replace the display module.

32 Battery Test Battery failure Replace the battery. If error persists, 
replace the logic module.

33.5 NVRAM Access Non-volatile memory failure Upgrade the system firmware to revision 
3.10.03 or later.

40 EXE Check System OS firmware is missing or 
corrupt.

Reload the firmware. If error persists, 
replace the internal compact flash card. If 
error still persists, replace the logic 
module.

50 External CF Error loading the OS firmware from 
the external compact flash card.

Reload the firmware. If error persists, 
replace the external compact flash card 
and attempt the firmware upgrade again.
Publication 6182H-UM001D-EN-P - September 2005



Troubleshooting        9-13
Startup Information 
Messages

The table provides a list of system information messages that display 
at startup. The messages are in the order that they appear on the 
terminal screen during startup and typically display for a few seconds.

Startup information messages show the startup sequence of the 
terminal but do not require that you perform any action.
 

Message # Displayed Message Description

37 Video Initialized Configures and initializes the graphics video system.

30 Watchdog Test Tests the watchdog circuitry to verify system integrity.

1 RAM Test Tests the RAM memory.

31 Stuck Key Checks the integrity of the function key hardware.

31.5 Stuck Touch Checks the integrity of the touch screen hardware.

32 Battery Test Checks the integrity of the battery hardware.

2.5 Registry Search Locates and loads the most recent, valid registry. Multiple 
copies of the registry are maintained. If power is lost 
during a registry update, a valid registry is available the 
next time power is applied to the terminal.

2 Image Search Checks for new OS firmware upgrade on the external 
compact flash card and the serial port.

50 External CF Transfers a new OS firmware upgrade from the external 
compact flash card to the terminal. Message may display 
for several minutes. 

23 Internal CF Programs the OS firmware just downloaded into the 
internal flash memory. Message may display for several 
minutes. 

24 CRC Check Checks the integrity of the OS firmware. 

28 Starting System Launches the operating system (OS).

29 System Check ### Internal file system integrity check (### is percent 
progress indicator).

29.1 System Check Internal file system integrity check disabled. Contact 
technical support.
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Startup Sequence This flow chart provides a sequence of startup operations for the 
terminal and shows system information messages that display on the 
terminal.

Power On

Display copyright message, bootcode versions and "Testing..." message

Initialize Video - Display "37 Video Initialized" 

Perform Power On Self Test -  
Display "30 Watchdog Test" 
Display "1 RAM Test" 
Display "31 Stuck Key" 
Display "31.5 Stuck Touch" 
Display "32 Battery Test"  
Display"2.5 Registry Search" 

Any POST failures?
Display "Error..."

message and HALT
Yes

Check for new OS 
Display " 2 Image Search"

Do serial or external CF card download?

Serial or CF card Download of OS  
Display "50 External CF" 

Program OS into flash 
Display "23 Internal CF"

Check OS integrity 
Display "24 CRC Check"

Jump to OS 
Display "28 Starting System"

Perform final system check 
Display "29 System Check" or 
Display "29.1 System Check" (if skipping check)

No

Yes

No
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System Identification Errors The error messages in this section appear on bootup if incorrect or 
invalid components are used with the VersaView CE terminal.

• The following dialog appears if a VersaView CE logic module is 
attached to a PanelView display module. It is recommended that 
you use a VersaView CE display module with a VersaView CE 
logic module. This is a warning allowing you to continue to 
operate.

• The following dialog appears if the VersaView CE logic module 
contains a 2711P-RWx internal compact flash card for the 
PanelView Plus terminal

.

After pressing OK, you will be asked to power of the terminal 
and insert a valid 6189-RWx internal compact flash card for the 
VersaView CE terminal.

• The following dialog appears if the PanelView Plus logic module 
contains a 6189-RWx internal compact flash card for the 
VersaView CE terminal.

After pressing OK, you will be asked to power off the terminal 
and insert a valid 2711P-RWx internal compact flash card for the 
PanelView Plus terminal.

• The following dialog appears if the internal compact flash in the 
VersaView CE logic module is corrupt or invalid. This is a fatal 
error

(6189-RWX)
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After pressing OK, you will be asked to power of the terminal 
and insert a valid 6189-RWx internal compact flash card.

Restart in Safe Mode Safe Mode is a diagnostics mode where the system is reduced to a 
known state that permits recovery from a software problem. Safe 
Mode ignores all user changes to the system and avoids any problems 
that are due to interactions with end-user software or changes. Once 
the system is running in Safe Mode, you can repair the offending 
applications or changes that caused the problem.

When the VersaView CE terminal is restarted in Safe Mode, the 
following occurs:

• The Persistent Registry is ignored and the Default Registry is 
used. The Persistent Registry is restored at the next reboot unless 
the Default Registry is saved (flushed), in which case it becomes 
the new Persistent Registry.

• The \Windows\Startup folder is ignored, inhibiting most startup 
actions. All user applications that launch automatically at startup 
are shortcuts in the \Startup folder.

• Depending on the state of the system, the touch screen may be 
calibrated at startup.

• All custom key configurations (mappings) generated by the 
Keypad Configuration Utility (KCU) are ignored.

To restart in Safe Mode:

The switches that control Safe Mode are on the right side of the logic 
module above the compact flash card slot.

1. Insert a thin probe into the hole marked DEFAULT and press the 
switch.

2. Insert the probe into the hole marked RESET and press the 
switch. The system will restart immediately into the Safe Mode.
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Firmware Upgrades The only way to upgrade the firmware is to use the Firmware 
Upgrade Utility as described in Chapter 8.

Operating System (OS)

The Operating System (OS) compressed binary image resides in a 
binary partition of the Internal (IDE) compact flash in the logic 
module. There are two ways to upgrade the OS:

• External compact flash card during a reboot

• LocalOSUpdate (LocalOSUpdate.exe) 

External Compact Flash Card 

To upgrade the OS using an external compact flash card:

1. Copy the operating system binary file, SYSTEM.BIN, to a 
compact flash card. The file must be named SYSTEM.BIN.

2. Remove power from the VersaView CE terminal.

3. Insert the compact flash card into the external card slot on the 
terminal.

4. Power up the VersaView CE terminal.  

The terminal automatically reboots with the new operating 
system.

Local OS Update 

To perform a local update of the operating system:

1. Copy the operating system binary file to a compact flash card. 

2. Insert the compact flash card into the external card slot of the 
VersaView CE terminal.

3. At a CMD prompt on the VersaView CE terminal, run:

LocalOSUpdate <Pathname and Filename>

Example:  LocalOSUpdate “\Storage card2\NewOS.BIN”

The terminal automatically reboots with the new operating 
system.

4. Verify the new operating system is loaded using the System 
application in the Control Panel.
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Load VersaView Components

You can Load VersaView Components using either: 

• ActiveSync connection or  

• External compact flash card

Using ActiveSync Connection

When the new operating system is running, load the VersaView 
CE components as follows:  

1. Establish an ActiveSync connection between your computer and 
the VersaView CE terminal, using either a Serial or Ethernet 
connection (Ethernet is recommended). Refer to page 8-1.

2. Open the VersaView folder on the Accessory CD and run the 
VersaViewCEInstall.exe program.  

This program allows you to select which features to install and 
automatically copies the files from the CD to the VersaView CE 
terminal. You must run the program from its directory, to ensure 
the program locates all the files correctly.

3. Select the desired components from the list of available 
components. Use the >> button to install everything. Once 
installed, components can be optionally removed to free space 
in the \Storage Card folder. When satisfied with the selections, 
press the Install/Remove button.

4. Depending on the options selected and the speed of your 
ActiveSync connection, the download process may take several 
minutes. For a serial ActiveSync connection at 19,200 baud, the 
download time can be 30 minutes. 

When the download is complete, you will see the number of 
files copied or deleted.  

5. Restart the VersaView CE terminal. 
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External Compact Flash Card

When the new operating system is running, load the VersaView 
CE components as follows:  

1. Open the VersaView CE folder on the Accessory CD and copy 
the following to an FAT formatted compact flash card:

• VersaViewCEinstall.exe

• VersaViewCEinstall.ini

• Storage Card File folder

2. Insert the compact flash card into the external card slot on the 
terminal. Using Windows Explorer, browse the \Storage Card 
folder and run VersaViewCEinstall.exe.

3. Select the desired components from the list of available 
components. Use the >> button to install everything. Once 
installed, components can be optionally removed to free space 
in the \Storage Card folder. When satisfied with the selections, 
press the Install/Remove button.

When the operation is complete, you will see a message box 
reporting the number of files installed (or removed).

4. Restart the VersaView CE terminal.
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Clean the Display Window

1. Disconnect power from the terminal at the power source.

2. Use a clean sponge or soft cloth with a mild soap or detergent to 
clean the display.

3. Dry the display with a chamois or moist cellulose sponge to 
avoid water spots.

Remove Paint and Grease 

Remove fresh paint splashes and grease before drying by rubbing 
lightly with isopropyl alcohol (70% concentration). Afterward, wash 
using a mild soap or detergent. Rinse with clean water.

Use a protective antiglare overlay for easier cleaning of display 
window. 

ATTENTION Use of abrasive cleaners or solvents may damage the 
display. Do not scrub or use brushes.
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Appendix A

Specifications

Electrical

Environmental

Display

DC Power
Input Voltage
Power Consumption

24V dc nom (18…32V dc)
70 W  max  (2.9A @24V dc)

AC Power (2711P-RSAC)
Input Voltage 
Line Frequency
Power Consumption

85…264V ac 
47…63 Hz
120 VA  max

Operating Temperature 0…55 °C (32…131  °F)

Storage Temperature -25…70  °C (-13 to 158 °F)

Heat Dissipation 240 BTU/hr

Relative Humidity 5…95% without condensation 

Altitude Operating 2000 m (6561 ft)

Shock Operating 15 g at 11 ms

Shock Non-Operating 30 g at 11 ms

Vibration 10…57 Hz, 0.012 pk-pk displacement
57…500 Hz, 2 g pk acceleration

Enclosure Ratings Nema Type 12, 13, 4X (indoor use only), 
IP54, IP65

Display Type Color Active Matrix TFT Thin-Film Transistor 
with LCD Liquid Crystal Display

Display Area Size
700H
1000H
1250H and 1250H High-Bright 
1500H

6.5 inch
10.4 inch
12.1 inch
15.0 inch

Display Area (W x H)
700H
1000H
1250H and 1250H High-Bright 
1500H

132  x 99 mm (6.7 inch diagonal)
211  x 158 mm (10.4 inch diagonal)
246 x 184 mm (12.1 inch diagonal)
304  x 228 mm (15.1 inch diagonal)
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Mechanical

Resolution
700H
1000H
1250H and 1250H High-Bright
1500H

640 x 480
640 x 480
800 x 600
1024 x 768

Luminance
700H - 1500H
1250H High-Bright

 
300 cd/m2  (Nits)
1000 cd/m2 (Nits)

Backlight 
700H - 1500H 
1250H High-Bright

 
CCFL 50,000 hours life, minimum 
Backlight not replaceable

Touch Screen 
Touch  Technology 
Actuation Rating
Operating Force

 
Analog resistive
1 million presses
10…110 g

Keypad 
Function Keys 
Actuation Rating 
Operating Force

 
Function Keys, numeric and navigation 
1 million presses 
340 g

Weight (for base unit without modules)
700H Keypad or Keypad & Touch
700H Touch 
1000H Keypad or Keypad & Touch
1000H Touch
1250H Keypad or Keypad & Touch
1250H Touch and 1250H High-Bright
1500H Keypad or Keypad & Touch
1500H Touch

1.9 kg (4.2 lbs)
1.7 kg (3.8 lbs)
2.9 kg (6.3 lbs)
2.6 kg (5.7 lbs)
3.4 kg (7.6 lbs)
3.2 kg (7.1 lbs)
4.6 kg (10.0 lbs)
4.2 kg (9.3 lbs)

Dimensions H x W x D (for base unit without communication module)

700H Keypad or Keypad & Touch 193 x 290 x 55 mm
7.58 x 11.40 x 2.18 in

700H Touch 179 x 246 x 55 mm
7.04 x 9.68 x 2.18 in

1000H Keypad or Keypad & Touch 248 x 399 x 55 mm
9.77 x 15.72 x 2.18 in

1000H Touch 248 x 329 x 55 mm
9.77 x 12.97  x 2.18 in

1250H Keypad or Keypad & Touch 282 x 416 x 55 mm
11.12 x 16.36 x 2.18 in

1250H Touch 282 x 363 x 55 mm
11.12 x 14.30 x 2.18 mm
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General

Agency Certifications

1250H High-Bright Touch 282 x 363 x 74 mm
11.12 x 14.30 x 2.90  mm

1500H Keypad or Keypad & Touch 330 x 469 x 65 mm
12.97 x 18.46 x 2.55 in

1500H Touch 330 x 416 x 65 mm
12.97 x 16.37 x 2.55 in

Battery Life 4 years minimum at 25 °C 

Clock Battery-backed, +/-2 minutes per month

LED Indicators COMM (Green), Fault (Red)

Application Flash Memory 12 MB

External Compact Flash Storage 512 MB maximum

UL Listed Industrial Control Equipment 
UL Listed Industrial Control Equipment for use in Canada 
UL Listed Industrial Control Equipment for use in:

• Class I, Div 2, Group A, B, C, D

• Class I, Zone 2, Group IIC (1)

• Class II, Div 2 Groups F, G

• Class III Hazardous Locations

(1) Applies only to the 1250H High-Bright Display Module

CE  marked for all applicable directives

C-Tick
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Appendix B

Programmable Key Definitions

The tables in this appendix shows the Windows virtual key code 
mapping of each programmable function key on the VersaView CE 
terminal. 

Function Key Mapping

Function Key Virtual Key 
Mapping

Function Key Virtual Key 
Mapping

F1 VK_F1 K1 RA + VK_F1

F2 VK_F2 K2 RA + VK_F2

F3 VK_F3 K3 RA + VK_F3

F4 VK_F4 K4 RA + VK_F4

F5 VK_F5 K5 RA + VK_F5

F6 VK_F6 K6 RA + VK_F6

F7 VK_F7 K7 RA + VK_F7

F8 VK_F8 K8 RA + VK_F8

F9 VK_F9 K9 RA + VK_F9

F10 VK_F10 K10 RA + VK_F10

F11 VK_F11 K11 RA + VK_F11

F12 VK_F12 K12 RA + VK_F12

F13 LS + VK_F1 K13 RS + VK_F1

F14 LS + VK_F2 K14 RS + VK_F2

F15 LS + VK_F3 K15 RS + VK_F3

F16 LS + VK_F4 K16 RS + VK_F4

F17 LS + VK_F5 K17 RS + VK_F5

F18 LS + VK_F6 K18 RS + VK_F6

F19 LS + VK_F7 K19 RS + VK_F7

F20 LS + VK_F8 K20 RS + VK_F8

F21 LS + VK_F9 K21 RS + VK_F9

F22 LS + VK_F10 K22 RS + VK_F10
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Alt, Control and Shift Key Mapping

The following table provides the Windows virtual-key code mapping 
for the Alt, Control and Shift keys on the VersaView CE terminal.

Keyboard 
Equivalent

Virtual Key 
Mapping

Control VK_LCONTROL

Shift VK_LSHIFT

Alt VK_LMENU
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Appendix C

Compatible USB Devices

The following table provides a list of compatible USB devices which 
can be used on the USB ports of the VersaView CE terminals.

Device Vendor Model PanelView Plus
700-1500

USB Keyboard Rockwell Automation Cat. No. 6189-KBDEPU1U Yes

Ortek MCK-600USB Yes

Dell RT7D10 Yes

USB 
Keyboard/Mouse

Rockwell Automation Cat. No. 6189-KBDEPC1U Yes

USB Mouse Logitec Optical Mouse - M-BJ58 Yes

Microsoft Intellimouse D58-00026 Yes

Atek USB Mouse Yes

VersaView (Rockwell 
Automation) 

USB Mouse Yes

USB Hub Belkin USB 4-Port Hub - ESU021 Yes
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Appendix D

Security Considerations

Ports 137 and 138 are normally open to support the NetBIOS protocol 
used by Windows CE.NET similar to other Microsoft and IBM network 
operating systems.

Port 80 is open when the web server is optionally installed from the 
VersaView extensions. Otherwise, Port 80 is normally closed.

The FTP server permits a remote computer to run arbitrary commands 
and read/write files. The FTP server is optionally installed from the 
VersaView extensions. Otherwise, there is no FTP server on the 
system.

SNMP (Simple Network Management Protocol) is not supported.

IGMP (Internet Group Management Protocol) is used for IPv4 
multicast. A multicast is communication between a single sender and 
multiple receivers on a network. IGMP is used to exchange 
membership status data between IPv4 routers that support 
multicasting and members of multicast groups. A router is an 
intermediary device on a communication network that expedites 
message delivery by finding the most efficient route for a message 
packet within a network, or by routing packets from one subnetwork 
to another. A subnetwork is a separate part of an organization’s 
network identified through IP addressing.

VersaView CE terminals provide level 2 (full) support for IPv4 
multicasting (IGMP version 2) as described in RFC 1112 and RFC 2236.

Security requires a comprehensive application of policies and 
technology, and an awareness of security needs and potential 
vulnerabilities. You may also want to consult with Rockwell GMS 
Network Services for additional assistance.
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Appendix E

Available Fonts for Terminal Applications

The following fonts are pre-installed on PanelViewPlus/VersaView CE 
terminals:

• True Type fonts (scalable)

– Tahoma.ttf (proportional)

– Courier.ttf (fixed width)

– Arial.ttf (proportional)

• (23) fonts of various sizes migrated from PanelView Standard 
and PanelView "e" terminals (various sizes)

To simplify the creation and downloading of .mer application files on 
these devices, use the above list of fonts when developing screens in 
RSView Studio.

Additional fonts are available in RSView Studio when developing 
application screens.

• If the font used to develop screens is not available on the target 
device, the closest font is selected. 

• If bolding or italics is used, and a separate bold or italics font is 
unavailable, then the target operating system will use an 
algorithm to produce these affects. 

In either case, the device screens will look different than they do in 
RSView Studio. 

Downloading Fonts to 
Terminal 

To use additional fonts on a PanelView Plus/VersaView CE device, 
copy any of the font files on the VersaView CE Accessories CD or the 
RSView Machine Edition Fonts CD to the following directory on the 
computer where RSView Studio is installed: 

c:\Documents and Settings\All Users\Documents\RSView Enterprise\ME\Runtime

You can now use the File Transfer Utility in RSView Studio to 
download the font file(s) to the target device:

1. Select Tools>Transfer Utility.

2. Select Source File>True Type Fonts.

3. Select a font file to download to the device and press the 
Download button.

VersaView CE    
Accessories CD

The following True Type fonts are included on the VersaView CE 
Accessories CD:

• Times New Roman.ttf

• Symbol.ttf

• Wingdings.ttf
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E-2        Available Fonts for Terminal Applications
RSView Machine Edition 
Fonts CD

Additional fonts are available on a CD, titled "RSView Machine Edition 
Fonts".  This CD is available from the Automation Bookstore 
(www.theautomationbookstore.com) at no charge.  

To download fonts that can be used on the PanelView Plus/VersaView 
CE terminals via the network, see the Rockwell Automation 
Knowledgebase (http://support.rockwellautomation.com). Select 
Knowledgebase under Self-Service Support (or Online Tools) and then 
enter Tech Note ID A66647102.

Fonts File Name Size (Bytes)

     Arial

          Arial (Subset 1_30) arial_1_30.ttf 153,720

          Arial Black arialk.ttf 117,028

          Arial Bold arialbd.ttf 288,496

          Arial Bold Italic arialbi.ttf 226,748

          Arial Italic ariali.ttf 207,808

     Comic Sans MS

          Comic Sans MS comic.ttf 126,364

          Comic Sans MS Bold comicbd.ttf 111,476

     Courier New

          Courier New (Subset 1_30) cour_1_30.ttf 162,460

          Courier New Bold courbd.ttf 312,920

          Courier New Bold Italic courbi.ttf 236,148

          Courier New Italic couri.ttf 245,032

     Georgia

           Georgia georgia.ttf 149,628

           Georgia Bold georgiab.ttf 141,032

           Georgia Bold Italic georgiaz.ttf 159,736

           Georgia Italic georgiai.ttf 157,388

     Impact impact.ttf 136,076

     Kino kino.ttf 28,872

     MSLogo mslogo.ttf 2,500

     Symbol symbol.ttf 69,464

     Tahoma

          Tahoma (Subset 1_07) tahoma_1_07.ttf 123,980

          Tahoma Bold tahomabd.ttf 295,432

     Times New Roman

          Times New Roman  (Subset 1_30) times_1_30.ttf 184,976

          Times New Roman Bold timesbd.ttf 334,944

          Times New Roman Bold Italic timesbi.ttf 239,692

          Times New Roman Italic timesi.ttf 248,368
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     Trebuchet MS

           Trebuchet MS trebuc.ttf 69,688

           Trebuchet MS Bold trebucbd.ttf 66,444

           Trebuchet MS Bold Italic trebucbi.ttf 66,348

           Trebuchet MS Italic trebucit.ttf 72,560

     Verdana

           Verdana verdana.ttf 149,752

           Verdana Bold verdanab.ttf 137,616

           Verdana Bold Italic verdanaz.ttf 154,800

           Verdana Italic verdanai.ttf 155,076

     Webdings webdings.ttf 118,752

     Wingding wingding.ttf 81,000

Chinese (Simplified)  Locale Specific Support

     Simsun & NSimSun 

           Simsun & NSimSun simsun.ttc 10,500,400

           Simsun & NSimSun (Subset 2_50) simsun_2_50.ttc 3,051,024

           Simsun & NSimSun (Subset 2_60) simsun_2_60.ttc 3,578,692

           Simsun & NSimSun (Subset 2_70) simsun_2_70.ttc 6,975,948

           Simsun & NSimSun (Subset 2_80) simsun_2_80.ttc 8,116,188

           Simsun & NSimSun (Subset 2_90) simsun_2_90.ttc 9,066,640

     SC_Song sunfon.ttf 4,686,044

Chinese (Traditional) Locale Specific Support

     MingLiU & PMingLiU(Choose 1)

           MingLiU & PMingLiU mingliu.ttc 8,822,400

           MingLiU & PMingLiU (Subset 2_70) mingliu_2_70.ttc 4,786,488

           MingLiU & PMingLiU (Subset 2_80) mingliu_2_80.ttc 5,772,700

           MingLiU & PMingLiU (Subset 2_90) mingliu_2_90.ttc 7,354,808

     MSMing msming.ttf 3,172,552

Japanese Locale Specific Support

     MS Gothic 

           MS Gothic & P Gothic & UI Gothic msgothic.ttc 8,272,028

           MS Gothic & P Gothic & UI Gothic (Subset 1_50) msgothic_1_50.ttc 4,456,536

           MS Gothic & P Gothic & UI Gothic (Subset 1_60) msgothic_1_60.ttc 6,057,400

     MS Gothic & P Gothic & UI Gothic (Subset 1_70) msgothic_1_70.ttc 3,795,500

           MS Gothic & P Gothic & UI Gothic (Subset 1_80) msgothic_1_80.ttc 5,438,776

           MS Gothic & P Gothic & UI Gothic (Subset 1_90) msgothic_1_90.ttc 6,408,352

           MS Gothic & P Gothic (Subset 30) msgothic30.ttc 4,197,524

           MS Gothic & P Gothic (Subset 30_1_19) msgothic30_1_19.ttc 3,304,056

Fonts File Name Size (Bytes)
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Korean Locale Specific Support

     GL_CE gl_ce.ttf 4,130,084

     Gulim & GulimChe (Choose 1)

           Gulim & GulimChe (Subset 1_30) gulim_1_30.ttc 3,010,268

           Gulim & GulimChe (Subset 1_40) gulim_1_40.ttc 4,683,896

           Gulim & GulimChe (Subset 1_50) gulim_1_50.ttc 7,128,756

           Gulim & GulimChe (Subset 1_60) gulim_1_60.ttc 9,360,100

Fonts File Name Size (Bytes)
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Rockwell Automation 
Support

Rockwell Automation provides technical information on the web to assist you 
in using its products. At http://support.rockwellautomation.com, you can find 
technical manuals, a knowledge base of FAQs, technical and application 
notes, sample code and links to software service packs, and a MySupport 
feature that you can customize to make the best use of these tools.

For an additional level of technical phone support for installation, 
configuration and troubleshooting, we offer TechConnect Support programs. 
For more information, contact your local distributor or Rockwell Automation 
representative, or visit http://support.rockwellautomation.com.

Installation Assistance

If you experience a problem with a hardware module within the first 24 
hours of installation, please review the information that's contained in this 
manual. You can also contact a special Customer Support number for initial 
help in getting your module up and running:

New Product Satisfaction Return

Rockwell tests all of its products to ensure that they are fully operational 
when shipped from the manufacturing facility. However, if your product is 
not functioning and needs to be returned:

United States 1.440.646.3223
Monday – Friday, 8am – 5pm EST

Outside United 
States

Please contact your local Rockwell Automation representative for any 
technical support issues.

United States Contact your distributor.  You must provide a Customer Support case 
number (see phone number above to obtain one) to your distributor in 
order to complete the return process.

Outside United 
States

Please contact your local Rockwell Automation representative for 
return procedure.
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